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produce better, more accurate results in less time. In this course, you’ll learn what these features 
are and how to put them to use. 
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Instructional Design 

This Self-Study course is designed to lead you through a learning process using instructional 
methods that will help you achieve the stated learning objectives. You will be provided with 
course objectives and presented with comprehensive information and facts demonstrated in 
exhibits and/or case studies. Review questions will allow you to check your understanding of the 
material, and a qualified assessment will test your mastery of the course. 

Please familiarize yourself with the following instructional features to ensure your success in 
achieving the learning objectives. 

Course CPE Information 
The preceding section, “Course CPE Information,” details important information regarding CPE. 
If you skipped over that section, please go back and review the information now to ensure you 
are prepared to complete this course successfully. 

Table of Contents 
The table of contents allows you to quickly navigate to specific sections of the course. 

Learning Objectives and Content 
Learning objectives clearly define the knowledge, skills, or abilities you will gain by completing 
the course. Throughout the course content, you will find various instructional methods to help 
you achieve the learning objectives, such as examples, case studies, charts, diagrams, and 
explanations. Please pay special attention to these instructional methods, as they will help you 
achieve the stated learning objectives. 

Review Questions 
The review questions accompanying this course are designed to assist you in achieving the 
course learning objectives. The review section is not graded; do not submit it in place of your 
qualified assessment. While completing the review questions, it may be helpful to study any 
unfamiliar terms in the glossary in addition to course content. After completing the review 
questions, proceed to the review question answers and rationales.

Review Question Answers and Rationales 
Review question answer choices are accompanied by unique, logical reasoning (rationales) as to 
why an answer is correct or incorrect. Evaluative feedback to incorrect responses and 
reinforcement feedback to correct responses are both provided. 

Glossary 
The glossary defines key terms. Please review the definition of any words you are not familiar 
with. 

Index 
The index allows you to quickly locate key terms or concepts as you progress through the 
instructional material. 
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Qualified Assessment
Qualified assessments measure (1) the extent to which the learning objectives have been met and 
(2) that you have gained the knowledge, skills, or abilities clearly defined by the learning 
objectives for each section of the course. Unless otherwise noted, you are required to earn a 
minimum score of 70% to pass a course. If you do not pass on your first attempt, please review the 
learning objectives, instructional materials, and review questions and answers before attempting to 
retake the qualified assessment to ensure all learning objectives have been successfully completed.

Answer Sheet 
Feel free to fill the Answer Sheet out as you go over the course. To enter your answers online, 
follow these steps:  

1. Go to www.westerncpe.com.
2. Log in with your username and password.
3. At the top right side of your screen, hover over “My Account” and click “My CPE.” 
4. Click on the big orange button that says “View All Courses.” 
5. Click on the appropriate course title. 
6. Click on the blue wording that says “Qualified Assessment.” 
7. Click on “Attempt assessment now.” 

Evaluation 
Upon successful completion of your online assessment, we ask that you complete an online 
course evaluation. Your feedback is a vital component in our future course development.  

Western CPE Self-Study 
243 Pegasus Drive 

Bozeman, MT 59718 
Phone: (800) 822-4194 

Fax: (206) 774-1285 
Email: wcpe@westerncpe.com 
Website: www.westerncpe.com 

Notice:  This publication is designed to provide accurate information in regard to the subject matter covered. It is 
sold with the understanding that neither the author, the publisher, nor any other individual involved in its distribution 
is engaged in rendering legal, accounting, or other professional advice and assumes no liability in connection with 
its use. Because regulations, laws, and other professional guidance are constantly changing, a professional should be 
consulted should you require legal or other expert advice. Information is current at the time of printing  

http://www.westerncpe.com/
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Learning Objectives 

Upon successful completion of this course, you will be able to: 
• Identify appropriate tools and their functionality within Excel in order to solve problems

and analyze data
• Identify the specific process and “clicks” for executing various functions within Excel
• Cite how to predict future outcomes using functions such as FORECAST, LINEST, and

TREND and to test them with regression analysis
• Specify how to handle multiple versions of budgets and forecasts with Scenario Manager
• Identify optimal solutions of multi-variable problems using Solver
• Specify how to manage risk and uncertainty with Excel add-ins such as RiskAMP
• Identify efficient ways to handle capital budgeting issues
• Recognize how to prepare budget reports, including consolidating reports
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Learning Objectives

Upon completing this course, participants will be able to:
• Cite how to predict future outcomes using functions such as 
FORECAST, LINEST, and TREND

• Cite how to handle multiple versions of budgets and forecasts with 
Scenario Manager

• Identify optimal solutions of multi‐variable problems using Solver 
• Identify how to manage risk and uncertainty with Excel add‐ins 
such as RiskAMP

• Cite how to handle capital budgeting issues more effectively
• Cite how to prepare budget reports—including consolidation of 
reports—more efficiently
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Budgeting and Forecasting Features in Excel 
For most accounting and financial professionals, the single most challenging task in preparing a budget or 

forecast is to predict, with some degree of certainty, future revenues and expenses. Fortunately, Excel has 

a number of tools for creating accurate forecasts in minimal amounts of time.  

Learning Objectives 
Upon completing this section, you should be able to: 

 Utilize the following tools in Excel budgeting and forecasting applications: 

o Data Tables, 

o Goal Seek, 

o Solver, and 

o Scenario Manager; 

 

 Discuss the importance of Regression Analysis when preparing budgets and forecasts and describe 

Excel’s regression features, including FORECAST, SLOPE, INTERCEPT, TREND, GROWTH, 

and LINEST; and 

 

 Describe how to analyze and manage risk with Monte Carlo simulations. 

 

 To use Solver and many of the functions mentioned in this course, you must have 

the Solver and the Analysis ToolPak Add-Ins installed.  Select File from the 

Ribbon, Options, and Add-Ins from the left navigation pane. At the bottom of 

the window, select Excel Add-ins from the Manage drop-down and select Go. 

In the Add-Ins window, check the boxes next to Analysis ToolPak, Analysis 

ToolPak – VBA, and Solver Add-in and click OK. This will enable both the 

Solver and Analysis ToolPak. Icons for Data Analysis and Solver are added on 

the Data tab of the Ribbon.   

 

Using Data Tables for Sensitivity Analysis 
One-variable and two-variable data tables have been a major spreadsheet analytical tool since Lotus 1-2-3, 

but, for many accountants, data tables have become a lost art. Data tables are an excellent method of 

conducting sensitivity or “what-if” analysis, which is an important aspect of forecasting data. In a simple 

one-variable data table, one variable is manipulated in calculating a result. In a two-variable data table, two 

variables are manipulated in calculating a result. 

In our first example, Debbie Nelson, the CFO of a small manufacturing company, is trying to use a one-

variable data table to forecast the impact of a change in unit sales price on the total sales revenue expected 

from a new product to be introduced in the coming year. In the table, the planned sales volume and unit 

7
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sales price are known. However, Nelson would like to calculate the sales revenue generated by unit prices 

ranging from $6.50 to $9.00 per unit.  

To work with data tables, begin by creating a worksheet with a layout similar to the one displayed at the 

left in Figure 1. Put the alternative prices in a single column, in this case in cells C11 through C21. Build 

a formula in cell D10 to calculate the estimated sales revenue from the planned sales volume and unit price. 

In a one-variable data table, the formula at the top of each column of the data table area is recalculated 

for each of the values in a single variable – in this case, unit sales price. To create the data table, highlight 

the range C10:D21 and select What-If Analysis, Data Table from the Data tab. In the Data Table dialog 

box, click in the box for the Column input cell and then click on cell D7. This process indicates to Excel 

where it is to substitute the values $6.50 through $9.00 in recalculating the total sales revenue. Click OK 

to produce the data table shown in the lower right of Figure 1. Note the formula in D11 is {=TABLE(,D7)}. 

 

Figure 1 - Creating a One-Way Data Table to Calculate Sales Revenue from Multiple Prices 

Nelson realizes that changing the unit sales price will affect the quantity sold. She would like to extend her 

analysis by stipulating various sales volumes as well as various sales prices in re-calculating the estimated 

8
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sales revenue from the introduction of the new product. Since two variables will be manipulated, this 

analysis will require a two-variable data table, shown in Figure 2.  

 

Figure 2 - Using a Two-Way Data Table to Compute Estimated Sales Revenue from Two Variables 

To create the two-variable data table shown in Figure 2, begin by creating the outline of the data table as 

shown in Figure 3. Note that in the outline shown, cell E9 contains the formula =E6*E7.  Note that cell 

C12 contains a cell reference back to cell E9, effectively replicating the formula in cell E9 into cell C12. 

Note, too, that the formula used to calculate total revenue is not limited to just the two variables in the data 

table and could contain references to other variables outside the data table.  

9
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Figure 3 - Outline of Two-Variable Data Table 

Once the outline of the two-variable data table is complete, select the range from cell C12 through cell J23. 

Then, from the Data tab, select What-If Analysis and Data Table to open the Data Table dialog box 

shown in Figure 4. In the Data Table dialog box, enter cell E7 as the Row input cell and cell E8 as the 

Column input cell and click OK. This instructs the data table to substitute the contents of the first row of 

the data table into cell E7 and the contents of the left-most column of the data table into cell E8 and to 

recalculate the formula in cell C12, placing the results in the “grid” of the data table. Upon completion, the 

two-variable data table resembles that shown in Figure 2. 

 

Figure 4 - Data Table Dialog Box 

Referencing Data Tables in Budgeting and Forecasting Models 
From a budgeting and forecasting perspective, once a data table has been constructed, users will likely need 

to reference data in the data table and use that data elsewhere in preparing budgeting and forecasting models. 

10
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One of the more effective means of doing so would be to use a double-lookup approach in which combining 

the power of VLOOKUP and MATCH functions is used to extract a specific element of a data table. 

Using the completed two-variable data table from our previous example as the starting point of this 

example, suppose the designer of a forecasting spreadsheet wanted to enable users to quickly extract data 

from a data table for use elsewhere in the model. In cell D6 of the snippet of the spreadsheet shown in 

Figure 5, the following formula examines the contents of the two-variable data table and returns the value 

that meets the criteria specified in cells D3 and D4 of Figure 5. 

 

In the formula shown above, the VLOOKUP function identifies the row that contains the Unit Price; the 

MATCH function identifies the column that contains the Sales Volume; and the IFERROR function traps 

any errors and replaces them with the phrase “Value Not Found.” Of course, by definition, the VLOOKUP 

function also returns the value at the intersection of the identified row and column. 

 

Figure 5 - Extracting Data from a Data Table 

Remember that data tables depend on a formula entered in their upper, left-hand corner to calculate the 

values appearing in the data table. Further, remember that this formula can be a very complex formula and 

is not limited to just the variables in the data table. With these factors in mind, it becomes apparent that 

using a data table to calculate values based on a complex formula and then using the data extraction 

technique described above can prove to be a very effective technique when building complex budgeting 

and forecasting models. 

Working with Excel’s Goal Seek Function 
Excel’s Goal Seek function is a tool that allows users to “back-in” to the value needed in a variable to 

produce a specific result. In other words, use Goal Seek when you already know what the answer is – or 

should be – and just need identify the value in a specific variable that will produce the intended result. 

In the following example, suppose Greg Adams, a budget analyst at GTM Manufacturing, has the 

responsibility of determining what level of sales revenue is needed to provide gross profit of $6 million for 

the upcoming fiscal year. Greg knows that GTM’s gross profit percentage averages 29%, so he could simply 

11
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divide $6 million by 29% to arrive at the necessary sales revenue of $20,689,655. Greg could also use Goal 

Seek to solve this problem. 

Using Goal Seek, Greg might construct a model similar to that shown in Figure 6. 

 

Figure 6 - Goal Seek Model 

When Greg constructs this model, he would access the Goal Seek dialog box by choosing What-If 

Analysis from the Data tab and selecting Goal Seek. Upon entering the information shown in Figure 6, 

Greg clicks OK in Goal Seek dialog box. Upon doing so, Goal Seek calculates the result and displays it as 

shown in Figure 7. 

 

Figure 7 - Completed Goal Seek Calculation 

Of course, rarely are the calculations required in preparing budgeting and forecasting models as simple as 

the one required by Greg in the previous example. Consequently, a more complex example is in order. In 

the next example, John Adams, the Chair of the School of Accountancy at State University, proposes to 

establish an endowed professorship at the school to teach Applied Technology to Accounting majors at the 

school. In considering the expected rate of return on the endowment, a professor’s initial annual salary, and 

annual cost of living and merit raises, Adams is attempting to determine the level of fundraising required 

to endow the professorship for a term of thirty years. 

After performing due diligence, Adams makes the following initial estimates regarding variables affecting 

the endowment. 

Expected Annual Investment Earnings Rate 

 

7.5% 

12
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Expected Annual Cost of Living and Merit Raises 

 

4.5% 

Expected Initial Salary $160,000 

 

To begin the process, Adams creates a schedule, a portion of which is shown in Figure 8. As shown there, 

if the professorship were endowed at $1 million, it would run out of money by year 8. 

 

Figure 8 - Proposed Endowment Schedule for State University 

Adams returns to the model and opens the Goal Seek dialog box. There, he uses Goal Seek to solve the 

equation by setting cell H34 (the ending balance for year 30) to 0 by changing the value in cell B4 (the 

beginning balance in the endowment) as shown in Figure 9. Once Adams establishes these parameters and 

clicks OK, Goal Seek approximates the amount required in the endowment at $3,051,7641. Note that the 

answer is approximate because, by default, Excel only runs 100 iterations in an attempt to find the correct 

answer. If Adams required a greater degree of precision, he could adjust the number of iterations for the 

workbook in Excel’s Formula Options. Additionally, rounding functions in the workbook also cause the 

calculation to be less accurate than is otherwise possible. 

  

                                                      

1 Those familiar with Excel’s financial functions could also solve this problem by using Excel’s PV function. 
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Figure 9 - Establishing Goal Seek Parameters for  

Calculating Required Initial Endowment 

While some avoid using Goal Seek because it is capable of solving equations with one variable only, as 

demonstrated above, the usefulness of Goal Seek is not limited to only simple “what-if” problems. 

Nonetheless, when requiring functionality in Excel to assist in solving multivariable problems, Excel’s 

Solver function is a better tool. 

Using Solver to Maximize Resources 
One of the key considerations for anyone involved in preparing revenue forecasts is to maximize profits, 

given available resources and operational and financial constraints. Constraints on profitability may take 

the form of distribution restrictions, production capacity limits, scarce inventory, or shortages of working 

capital caused by growth in accounts receivable or inventory. Whatever the nature of the constraints, it is 

the goal of every financial manager to find solutions that maximize the value of the organization. Excel's 

Solver add-in can assist in that process. 

Solver is used to find optimal solutions to linear programming models. For example, Solver can be used to 

maximize gross profits by calculating the optimal mix of products sold, to minimize interest expense by 

finding an optimal capital structure for the company, or to maximize production output by calculating the 

most efficient production runs. Solver optimizes a value in one cell of a workbook by adjusting various 

input cells, subject to user-specified constraints placed on the input cells. 

In this example, the CFO of a medical technology lab seeks to maximize the gross profit generated by a 

piece of testing equipment. The equipment can perform three different tasks, each with different billing 

rates, marginal costs, and gross profits. Further, the maximum number of units that can be sold of each 

procedure varies. Table 1 displays the relevant data. 

  

14



Page 9 of 94 
      

Copyright © 2016, K2 Enterprises, LLC. 
Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

 Task A Task B Task C 

Billing Rate $350 $250 $200 

Marginal Cost $175 $50 $100 

Gross Profit Per Unit 

Sold 

$175 $200 $100 

Max Number Of 

Sales Per Year 

500 minus 1/2 of the 

instances of Tasks B 

and C sold for the year 

500 minus 1/2 of the 

instances of Task C sold 

for the year 

500 

Table 1 - Relevant Data for a Solver Equation 

In addition to the data presented in Table 1, no more than 750 procedures in total can be sold during the 

year, and a minimum of 50 units of each procedure must be sold. Given these constraints, the CFO must 

calculate the optimal mix of sales units of each task in order to maximize overall gross profit. Using Solver, 

a solution for this complex revenue maximization model can be calculated in short order. 

First, build the basic structure of the worksheet as shown in Figure 10. The second panel in the figure 

displays the underlying formulas. 

 

Figure 10 - Constructing a Worksheet with the Appropriate Structure and Formulas 

To begin the process of finding a solution, click Solver on the Data tab to open the Solver Parameters 

dialog box as shown in Figure 11. In the Solver Parameters dialog box, specify the target cell to be 

optimized, in this case cell F7. The variable cells to be adjusted include the range of cells B6:D6. The 

relevant constraints are described in the table above. Click the Solve button, and Solver will attempt to find 

a solution based on the input cells and constraints identified. When the results are calculated, select Keep 

Solver Solution in the Solver Results dialog box and click OK. 

15
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Figure 11 - Specifying the Parameters for a Solver Optimization 

The solution suggested by Solver is presented in Figure 12. Maximum profits are generated when 225 units 

of Task A, 475 units of Task B, and 50 units of Task C are sold. Closer inspection reveals that at least 50 

units of each task are sold, that the total number of all tasks being sold is less than or equal to 750 units, 

and that the number of units of each task sold is less than or equal to the maximum number available. 
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Figure 12 - Results of Solver Produced Profit Maximization 

In addition to the computational efficiency of Solver, users can benefit from its documentation features in 

the form of several reports. The Solver Answer Report is shown in Figure 13. 

 

Figure 13 - Answer Report Generated with a Solver Solution 

In addition to Answer reports, Solver can also generate Sensitivity Analysis and Limits reports. Further, 

users can save Solver solutions as Scenarios to be recalled later in Scenario Manager. 
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Scenario Manager 
Managing Different Sets of Assumptions with Scenario Manager 

Scenario Manager is a feature in Excel that provides users with the ability to see results under different 

sets of assumptions without needing to create multiple versions of worksheets or workbooks. In Scenario 

Manager, users specify the variable(s) to be changed and what the changes are. Then, whenever results are 

to be displayed based on a particular set of assumptions, Scenario Manager automatically recalls the 

assumptions and inserts them into the spreadsheet. 

To illustrate how Scenario Manager works, consider the budget assumptions shown in Table 2 for three 

different sets of circumstances. 

 Best Case Most Likely Case Worst Case 

A/R Collection Period 34 37 43 

Days Sales In Inventory 18 24 36 

Days Purchases In A/P 27 34 45 

Gross Profit Percentage 49% 47% 43% 

Interest Rate On Line Of Credit 5% 6% 8% 

Total Sales $900,000 $800,000 $700,000 

Wages $195,000 $200,000 $225,000 

Table 2 - Scenario Manager Assumptions 

Each of the assumptions associated with each set of circumstances can be loaded and saved under Scenario 

Manager by selecting Data, What If Analysis, and Scenario Manager from the Ribbon and clicking the 

Add button. In the Add Scenario dialog box shown in Figure 14, enter a name for the scenario, the cells 

to be changed, and any desired comments. Clicking the OK button advances users to the Scenario Values 

dialog box shown in Figure 15. 
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Figure 14 – Adding Scenario Dialog Box 

In the Scenario Values dialog box, the values to be associated with each variable being changed under the 

scenario are entered. Once all values have been entered, click OK to save the data. 

 

Figure 15 - Scenario Values Dialog Box 

To see the results of a particular scenario, simply double-click the desired scenario in the Scenario Manger 

dialog box. At that point, the cell values associated with each variable identified in Scenario Manager are 

changed to reflect the values for that scenario. This effectively allows users to track multiple versions of 

the same budget. Further, Scenario Manager allows users to generate a Scenario Summary report showing 

the impact of changing the variables under each Scenario on selected “Result Cells.” Figure 16 displays an 

example of one such report. 
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Figure 16 - Scenario Summary Report 

In addition, Scenario Manager can be used to consolidate different Scenarios from various worksheets and 

other workbooks. A budget analyst, for example, could distribute budget workbook templates to other users 

who create their own Scenarios. The analyst could then merge these Scenarios into a “master” workbook 

by using the Merge Scenarios feature shown in Figure 17. To merge Scenarios, navigate to Data, What 

If Analysis, and Scenario Manager and select the Merge button. In the Merge Scenarios dialog box, 

simply highlight the workbook and worksheet where they reside and click OK. 

 

Figure 17 - Merging Scenarios 

From the Scenario Manager dialog box, you can highlight a scenario name, click Edit, and edit the values 

within the scenario cells. You can also delete scenarios no longer needed.  

The Summary button is useful for generating a report comparing the input values of all the summaries 

created as shown in Figure 18.   
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Figure 18 - Generating a Scenario Summary Report from the Scenario Dialog Box 

The report would be even more useful if the Changing Cells and Result Cells were descriptive names 

rather than coordinates.  To accomplish this, add Defined Names to those cells before generating the 

Scenario Summary.  The summary reports are not interactive.  Therefore, if you change the scenario values 

or add scenarios, delete the sheet tab with the old report and generate a new Summary report from the 

Scenario dialog box. 

As shown in Figure 19, Scenario Manager is also represented by a tool that can be added to the Quick 

Access Toolbar.  The tool provides a drop-down list of all the Scenario names for the active sheet and 

populates the changing values cells when a name is selected. Right-click the Quick Access Toolbar and 

select Customize Quick Access Toolbar. In the Choose commands from the drop-down, select All 

Commands. Scroll down, click the Scenario tool,  and click the Add button to place it on the Quick Access 

Toolbar. Click OK.  

 

Figure 19 - Scenario Manager Tool on Quick Access Toolbar 

Integrating Scenario Manager and Solver 
Returning to the previous discussion of Solver, if you need to retain the input values for future use, select 

Save Scenario in the Solver dialog box as shown in Figure 20. You are prompted to enter a Scenario 

Name. The Scenario Manager uses the reference in the By Changing Cells box in the Solver Parameters 

dialog box to determine what values are stored. 
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Figure 20 - Creating a Scenario from a Solver Solution 

Scenario Manager features are useful with Solver because the scenarios are intended to capture changing 

input cells upon which formulas depend.  The only limit of this feature is that a scenario can only hold up 

to 32 changing cells. 

Forecasting with Regression Analysis 
Regression analysis is a statistical method used to estimate and understand relationships between a 

dependent variable and one or more independent variables. Linear regression models the relationship 

between two or more variables by fitting a linear equation to observed data.  

With regression analysis, one or more independent variables predict a single dependent variable. For 

example, a sales executive may want to investigate the effect of advertising expenditures on sales revenue. 

Relationships are explained by this linear regression equation. 

Υ = α + βx 

Y is the dependent variable (sales revenue). 

α is the intercept (the value of Y when x = 0). 

  β is the slope of the line. 

  x is the independent variable (advertising expenses). 

The correlation coefficient quantifies the strength of the association between the independent and dependent 

variables. The correlation coefficient always takes a value between minus one and plus one, with plus one 

or minus one indicating perfect correlation (with all points along a straight line). A positive correlation 

indicates a positive association between the variables. Increasing values in one variable correspond to 

increasing values in the other variable. A negative correlation indicates a negative association between the 

variables. Increasing values in one variable correspond to decreasing values in the other variable. A 

correlation value of zero indicates that there is no association between the variables. 
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R² is the square of the correlation coefficient. It shows the percentage of variation in the dependent variable 

explained by variation in the independent variable. When the correlation is 0.80 between the variables sales 

revenue and advertising expense, then the linear regression model calculates that 64% (0.802) of the 

variability in the data is predictable. The major conceptual limitation of regression analysis is that one can 

ascertain relationships but can never be sure about the underlying causal mechanism.  

For example, a strong positive relationship may exist between the number of overtime hours worked by 

production personnel and the quantity of goods produced, but a regression analysis cannot support the 

conclusion that the quantity of goods produced actually caused the overtime. Other factors, such as 

machinery breakdowns or production line inefficiencies, may have caused it. While regression analysis can 

quantify the relationship between overtime hours worked and quantity of goods produced, it cannot explain 

the cause of the relationship. 

Regression Analysis in Excel 
Excel contains a number of tools that are useful in conducting regression analysis. The regression analysis 

tool in the Analysis ToolPak add-in allows estimation of a single dependent variable based on up to sixteen 

independent variables. Regression analysis is not the only tool available in the ToolPak. Tools are also 

available to compute descriptive statistics, calculate moving averages and ANOVAs, generate random 

numbers, determine ranks and percentiles, and more. 

In our first example, a sales executive wants to determine if there is a relationship between monthly revenue 

and advertising expenditures incurred in the previous month. Used here, regression analysis will determine 

the strength of the relationship between these variables and will forecast future sales revenues.  

Consider the data shown in Figure 21, which summarizes monthly revenue and advertising expenditures 

for the past thirty months. Note the general trend in the data. As advertising expenses for the prior month 

increase, sales revenues for the current month increase. As advertising expenses for the prior month 

decrease, sales revenues for the current month decrease. The scatter chart displayed in Figure 22 shows 

this relationship. Visual scrutiny of the scatter chart suggests that a significant relationship exists between 

monthly sales revenue and advertising expenses incurred in the previous month. 
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Figure 21 - Regression Analysis Data Set 
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Figure 22 - Scatter Chart of the Regression Analysis Data Set 

To begin the regression estimation process, click Data Analysis on the Data tab. Then, select Regression 

in the Analysis Tools list of the Data Analysis dialog box and click OK as shown in Figure 23. 

 

Figure 23 - Selecting Regression in the Data Analysis Dialog Box 

In the Regression dialog box shown in Figure 24, click the Collapse Dialog button just to the right of the 

Input Y Range box and select the range of cells that contains the dependent variable. In this case, select 

the range A2:A31, Monthly Sales. Next, click the Collapse Dialog button just to the right of the Input X 

Range box and select the range of cells that contains the independent variable. In this case, select the range 

B2:B31, Ad Expense 1 Month Prior. Note that the number of observations in the X and Y ranges must be 

equal.  
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Figure 24 - Specifying the X and Y Ranges in a Simple Linear Regression 

Click OK to calculate the regression and display the results on a new worksheet as shown in Figure 25. 

 

Figure 25 - Linear Regression Analysis Based on a Single Independent Variable 

When interpreting the regression results, key components to consider are R Square, the Intercept 

Coefficient, and the X Variable 1 Coefficient. Recall that R Square is a measure of fit – it measures how 

well the computed linear equation fits the data. Generally, an R Square value of 0.80 or higher means that 

there is a strong relationship between the independent variable(s) and the dependent variable. In this 

example, the R Square is calculated to be 0.9118, which indicates a strong relationship between the 

variables and that the linear equation fits the data very well. 
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The Intercept Coefficient and the X Variable 1 Coefficient are used to specify the equation for estimating 

or predicting new values of the dependent variable based on specified values of the independent variable. 

In this case, the equation for estimating monthly sales as a function of the advertising expense incurred in 

the prior month is as follows. 

Monthly Sales = $10,538 + (85.179 * Ad Expense 1 Month Prior) 

To forecast the sales revenue for a future month based on anticipated advertising expenses of $25,000 in 

the prior month, simply substitute the anticipated advertising expenses into the equation and solve for 

monthly revenue. 

Monthly Revenue = $10,538 + (85.179 * $25,000) 

$2,140,013 = $10,538 + (85.179 * $25,000) 

In this case, the regression equation yields estimated sales revenue of $2,140,013. 

The regression analysis tool can regress up to sixteen independent (predictor) variables on a single 

dependent variable. To include more independent variables in the regression, simply expand the X Input 

Range to include the observations of the additional variables.  

For example, many experienced marketing executives argue that advertising expenses have a lasting impact 

on sales. To include advertising expenses incurred two months prior to the measurement of sales revenue, 

simply expand the X Input Range to include the column that contains the additional observed advertising 

expenses. In this example, the Input X Range is expanded to include two months of advertising expenses 

– range B2:C31, as shown in Figure 26. 

 

Figure 26 - Specifying the X and Y Ranges in a Multiple Linear Regression 

The multiple linear regression performed in this example yields the calculations displayed in Figure 27. 
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Figure 27 - Linear Regression Analysis Based on Multiple Independent Variables 

The results of the multiple linear regression suggest a better fit of the data since R Square has increased 

from 0.9118 in the simple linear regression to 0.9312 in the current analysis. The results support the 

assertion that advertising expenditures – at least in this sample – have a lasting effect. In examining the 

summary output, a second X variable coefficient has been added to coincide with the inclusion of the second 

independent variable. The formula for predicting sales revenue based on advertising expenditures must be 

revised to include a second advertising estimate, shown below. 

Monthly Sales = $-91,683 + (73.038 * Ad Expense 1 Month Prior) + (17.009 * Ad Expense 2 Months 

Prior) 

Adding a Trendline to a Scatter Chart 
An alternative to using the regression analysis tool for generating a regression equation from which to 

forecast future revenues or expenses would be to add a linear trendline with the equation and R Square 

displayed on a scatter chart of the data points as shown in Figure 28. 

28



Page 23 of 94 
      

Copyright © 2016, K2 Enterprises, LLC. 
Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

 

Figure 28 - Adding a Linear Trendline with R Square and Equation to a Scatter Chart 

Adding a linear trendline uses the same least-squares process to calculate the results. Note that the R Square 

and regression equation are exactly the same as that produced using the regression tool in the Analysis 

ToolPak. 

To add a trendline to a scatter chart, right-click on one of the data points in the chart and select Add 

Trendline. In the Format Trendline dialog box, click Linear as the Trend/Regression Type and check 

Display Equation on Chart and Display R-squared value on chart as shown in Figure 29. 
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Figure 29 - Adding a Linear Trendline to a Scatter Chart 

Using Regression Functions 
In addition to adding trendlines to charts, Excel contains a number of statistical functions for calculating 

the components produced by a regression analysis. These functions allow a user to construct simple 

formulas on observed data for producing the regression equations useful in forecasting revenues or 

expenses. 

 FORECAST 

 SLOPE 

 INTERCEPT 

 TREND 
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 GROWTH 

 LINEST 

FORECAST is used to calculate or predict a value based on existing values. Using the sample data as an 

example, the formula =FORECAST(25000,A2:A31,B2:B31) would predict the monthly sales associated 

with advertising expenses of $25,000 one month prior, given the linear relationship between the independent 

variable in range B2:B31 and the dependent variable in range A2:A31.  

In effect, the FORECAST function generates the linear regression equation to predict monthly sales from 

advertising revenue. However, this method does not calculate or display R Square, nor does it show the 

intercept or slope of the linear equation. Nevertheless, for estimating revenues and expenses when 

relationships are known to exist, and the data fit is good, FORECAST is an excellent alternative for predicting 

values using simple formulas. 

SLOPE calculates the slope of the linear regression line, given the values of the independent variables 

and dependent variable. Using the sample data, the formula =SLOPE(C2:C32, B2:B32) will calculate a 

linear slope of 85.179, the same value computed using the simple linear regression analysis discussed earlier 

in this section. 

INTERCEPT calculates the intercept of the regression line, given the values of the independent variables 

and dependent variable. Again, using the sample data, the formula =INTERCEPT(C2:C32,B2:B32) will 

calculate an intercept of $10,538, the same value computed using the simple linear regression analysis. 

TREND generates values along a linear trendline and can be used to predict multiple future dependent 

values based on the relationship between existing dependent and independent variables. Note that TREND 

formulas are array formulas and must be entered using CTRL+SHIFT+ENTER.  

GROWTH is very similar to TREND except that GROWTH provides an exponential calculation rather 

than a linear calculation as provided by the TREND function. Like TREND, the GROWTH function must 

be entered as an array formula. 

LINEST can be used to produce an array formula to calculate the slope and intercept of a linear regression 

without using the Analysis ToolPak. It also can be used to generate descriptive statistics regarding the linear 

regression, including R Square. As shown in Figure 30, LINEST calculates the slope and intercept based 

on the input of the dependent and independent variables in an array formula. Prior to entering the formula, 

select two adjacent cells such as cells E2 and F2 to produce the output displayed. To modify the LINEST 

formula so that it returns descriptive statistics, first highlight a range that is two columns wide by five rows 

deep and then enter the following array formula. 
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Figure 30 - Using LINEST to Calculate the Regression Intercept and Slope 

Calculating and Charting Moving Averages 
Moving averages can be useful in projecting revenues and expenses and in evaluating projections for 

reasonableness. Unlike traditional averages, moving averages are useful in identifying trends in the 

underlying data and in smoothing period-to-period fluctuations.  

For example, the chart in Figure 31 depicts a moving average calculation of operating expenses using the 

prior six months as the baseline for the calculation. The smoothed line represents the moving average, while 

the jagged line represents the actual values. 
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Figure 31 - Smoothed Moving Average of Actual Operating Expenses 

Excel has two tools to assist users in calculating moving averages. The first is in the Analysis ToolPak, and 

the second is integrated within Excel's charting functionality. The moving average tool found in the 

Analysis ToolPak calculates moving averages and provides users with the option of plotting these values 

on a chart.  

To use the tool, select Data Analysis on the Data tab and then choose Moving Average in the Data 

Analysis dialog box. Enter a single data Input Range, an Interval over which the average will be 

calculated, and an Output Range. Note that the Output Range must be on the same sheet as the data. Check 

Chart Output to create a chart of the original data and the calculated moving average. The process for 

using the moving average tool is displayed in Figure 32. 
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Figure 32 - Calculating and Charting Moving Averages with the Analysis ToolPak 

Alternatively, moving averages can be plotted as trendlines on charts. To add a moving average trendline 

to an existing chart, right-click on any data element on the chart and select Add Trendline. Then, select 

Moving Average and enter the appropriate period over which to calculate the average in the Format 

Trendline dialog box. Format the Line Color, Line Styles, and Shadow as desired. The process and 

resulting moving average trendline are shown in Figure 33. 
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Figure 33 - Adding a Moving Average Trendline to a Scatter Chart 

Analyzing Risk with Monte Carlo Simulations 

What is Risk Analysis? 
In a broad sense, risk analysis is any method, qualitative and/or quantitative, for assessing the impacts of 

risk on decision situations. The goal of any of these methods is to help the decision maker choose a course 

of action, given a better understanding of the possible outcomes that could occur.  

The techniques of risk analysis have long been recognized as powerful tools to help decision makers 

successfully manage situations subject to uncertainty, such as forecasting revenues, expenses, and other 

inputs into budgets. Their use has been limited because they have been expensive, cumbersome to use, and 

have substantial computational requirements. However, the introduction of more powerful personal 

computers in business and in science has made it possible for these techniques to be commonly available 

to all decision makers. 

Many of the risk analysis applications available are add-ins to Microsoft Excel. With these add-ins and 

Excel, risk can be effectively analyzed. Risk analysis is used to improve the picture of what the future could 

hold. Traditionally, analyses combine single point estimates of a spreadsheet model’s variables to predict a 

single result. This is the standard Excel model – a spreadsheet with a single estimate of results. Estimates 

of critical variables must be used because the values that will actually occur are not known with certainty.  
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In reality, however, many things don’t turn out as planned. Maybe some of the estimates are too 

conservative, and others are too optimistic. The combined errors in each estimate often lead to a real-life 

result that is significantly different from the anticipated result. A decision made based on the anticipated 

result may be the wrong decision, a decision that would never have been made if a more complete picture 

of all possible outcomes had been available. Business decisions, technical decisions, and scientific decisions 

use estimates and assumptions. Using risk analysis applications, uncertainty present in our estimates can be 

explicitly included in models to generate results that show all possible outcomes. 

Simulation Sampling Techniques 
Simulation refers to any analytical method used to imitate a real-life system. Monte Carlo simulation is a 

stratified sampling technique used for obtaining numerical solutions to problems that are too complicated 

to solve analytically. Monte Carlo is a stochastic process – it uses random numbers and statistics to 

investigate or solve a problem. 

Excel models are deterministic. That means that the inputs are fixed: each cell has only one value. Without 

the aid of simulation, a spreadsheet model only produces a single outcome, generally the most likely or 

average result. Spreadsheet risk analysis uses both a spreadsheet model and simulation to automatically 

analyze the effect of varying inputs, such as interest rates, staffing needs, stock prices, inventory levels, 

phone calls per minute, or rainfall per year, on outputs of the modeled system. 

A Monte Carlo simulation calculates multiple scenarios of a model by repeatedly sampling values from the 

probability distributions of the uncertain variables and using the calculated values for the variable input 

cells. During a single trial, Monte Carlo randomly selects a value for each variable, given the range and 

shape of the underlying distribution of the variable and then recalculates the spreadsheet. A true simulation 

consists of multiple trials – hundreds or thousands of trials – in which the outcomes of all combinations of 

all variables are calculated in just a few seconds. The calculated results identify a distribution of possible 

outcomes around which can be calculated the mean, standard deviation, and confidence interval. 

What Risk Analysis Can and Cannot Do 
Quantitative analysis techniques have gained a great deal of popularity with decision makers and analysts 

in recent years. Unfortunately, many people have mistakenly assumed that these techniques are magic 

"black boxes" that unequivocally arrive at the correct answer or decision. No technique, including those 

used by Excel add-ins, can make that claim.  

These techniques are tools that can be used to help make decisions and to arrive at solutions. Like any tools, 

they can be used to good advantage by skilled practitioners, or they can be used to create havoc in the hands 

of the unskilled. In the context of risk analysis, quantitative tools should never be used as a replacement for 

personal judgment.  

Finally, you should recognize that risk analysis cannot guarantee that the action you choose to follow, even 

if skillfully chosen to suit your personal preferences, is the best action viewed from the perspective of 

hindsight. Hindsight implies perfect information, which you never have at the time a decision is made. With  

risk analysis, you can guarantee, however, that you have chosen the best strategy given the information that 

is available to you at the time the decision is made – and that’s not a bad guarantee! 
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Risk Analysis Applications 
There are several competing risk analysis applications. Most are add-ins to Microsoft Excel. Some, such as 

@Risk from Palisade Software and Crystal Ball from Decisioneering, are very sophisticated. Others do 

simulation without the frills. With these simple applications, the number of built-in distributions may be 

limited, or the reporting or graphic presentation of the results may be limited. Here is a short list of risk 

analysis applications suitable for use in a business setting, including developer contact details and pricing. 

@RISK 

Application Fact Sheet 

 Microsoft Excel add-in 

 37 built-in distributions 

 Comprehensive group of add-on modules 

 Multiple editions and pricing 

Standard Edition, $1,195 

Professional Edition, $1,495 

Industrial Edition, $1,995 

 Best Fit, Goal Seek, Stress Analysis, and Advanced Sensitivity Analysis 

 Risk Optimizer and Risk Accelerator 

 Current Version:  5.0 

 Company Contact Information 

Palisade Corporation 

798 Cascadilla Street 

Ithaca, NY 14850-3239 

1.800.432.7475 

www.palisade.com  

 

Oracle Crystal Ball 

Application Fact Sheet 

 Microsoft Excel add-in 

 20 built-in distributions plus custom distributions 

 Pricing Per User: $995 

 Company Contact Information 

303.334.6835 

www.oracle.com/crystalball/  

Risk Analyzer 

Application Fact Sheet 

 Microsoft Excel add-in 

 8 built-in distributions plus custom distributions 

 Comprehensive group of add-on modules 

 Single edition and pricing 

Standard Edition,  $79.95 

 Company Contact Information 
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Macro Systems 

144 Dewberry Drive 

Hockessin, DE  19707 

1.302.234.9857 

www.add-ins.com/analyzer  
 

RiskAMP Monte Carlo Add-in for Excel 

Application Fact Sheet 

 Microsoft Excel add-in 

 20 built-in distributions  

 Limited group of add-on modules 

 Single edition and pricing 

Personal Edition: $129.95 

Professional Edition:  $249.95 

 Current Version: 2.97 

 Company Contact Information 

Structured Data, LLC    

New York, NY 

1.800.573.6559 
www.riskamp.com  

 

Case Study of Modeling Risk When Forecasting Revenues 
Traditional analysis of proposed capital budgeting projects or new product introductions combine single 

point estimates of variables in a spreadsheet model to yield a single predictive result. Estimates of critical 

variables are used because the values that will actually occur are not known with certainty. In reality, 

however, many things don't turn out as planned. Some of the estimates are likely to be too conservative, 

while others will likely be too optimistic. The combined errors in each estimate often lead to a real life 

result that is significantly different from the one anticipated. A decision made based on the expected result 

from a simple Excel model may be the wrong decision – a decision that would never have been made if a 

more complete picture of all possible outcomes were available. That's where Monte Carlo simulation comes 

it. Monte Carlo is used to produce models that consider all possible outcomes, given the likelihood of each 

assumption, and identify the assumptions that most effect the outcome of a decision.  

To setup a project cash flow model to use Monte Carlo simulation with RiskAMP, users must first specify 

all assumption input cells as distributions instead of point estimates. Select Insert Distribution from the 

Monte Carlo tab of the Ribbon to open the Insert Random Distribution dialog box. Select a common 

distribution and then fill in the requested ranges. Figure 34 shows a user specifying the assumption input 

of expected unit sales as a Triangular Distribution with Minimum, Most Likely, and Maximum values 

of 3200, 3500, and 3800 units respectively. Once the model has been updated so that all of the point 

estimates have been replaced with an appropriate distribution, users are ready to setup a results sheet on 

which to output the results, and run a simulation. 
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Figure 34 - Specifying an Assumption as a Distribution in RiskAMP 

To setup a results sheet, select Histogram & Chart Wizard from the Monte Carlo tab of the Ribbon. 

Specify the results cell of your model, in this case the cell containing the estimated NPV for the new product 

introduction, and then choose to Create a new Simulations Results Sheet. Click Run a Monte Carlo 

Simulation and check Chart the results table data to produce the output displayed in Figure 35. 
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Figure 35 - Simulation Results of 5,000 Iterations in RiskAMP 

From the results, an analyst can easily determine that the NPV of the proposed new product introduction 

ranges from a minimum of -$696,468 to a maximum of $589,359, a range of $1,285,827, with a mean result 

of $88,447. Reading from the percentile distribution, a decision maker would be 90% confident that the 

NPV will range from -$309,401 to $407,562. Also, note that there is more than a 30% chance that the 

project will result in negative NPV. As you can see, the evaluative information provided by simulation 

results is far superior to simple point estimate models.  

A formal risk assessment requires the correlation of the individual assumptions with the target output. 

Notwithstanding that a simulation produces superior information for decision making than point estimate 

models, the simulation results do not identify which of the assumptions has the greatest impact on NPV. 

RiskAMP calculates but does not automatically present this information, but analysts can examine these 

relationships with the custom functions provided with the RiskAMP add-in. The two functions that are most 

relevant to this analysis are SimulationCorrelation (SCorr) and SimulationRSquare (SRSq). SCorr 

returns the correlation coefficient for the relationship between the simulation output (in this case, NPV) and 

a specified simulation assumption input. It measures the strength of the relationship between the output and 

an individual input. SRSq is simply the square of the correlation coefficient. It measures the percentage 

variability in the output explained by the variability of an individual input. By building a few simple 

formulas, one for each assumption input, an analyst can determine which inputs have the greatest impact 

on the output. Figure 36 presents just such an analysis along with an explanatory chart. 
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Figure 36 - Sensitivity of Project NPV to Assumption Inputs 

As can be seen from the risk analysis, project NPV is most sensitive to unit production cost, competitor 

entry, overhead costs, and the operating expense factor, with over 50% of the variability in the project NPV 

explained by the variability in unit production cost. With this information in hand, managers should focus 

their attention on reducing project risk due to these factors. For example, unit production costs may be 

reduced and better controlled through outsourced manufacturing, especially if the company's manufacturing 

resources were old and required constant maintenance to keep them in tolerance. 
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Capital Budgeting with Excel 
Capital budgeting is an important function in most organizations. Capital expenditures for equipment 

replacement, facility expansion or modernization, and other strategic purposes represent some of the largest 

expenditures made by businesses.  

Learning Objectives 
Upon completing this section, you should be able to: 

 Distinguish between cash flows and accounting income and identify which should be used in capital 

budgeting decisions; 

 

 Explain the difference between nominal and real cash flows and why consistency in their use is 

critical to capital budgeting equations; 

 

 Describe, at a high level, how to compute weighted average cost of capital; 

 

 Distinguish between net present value and internal rate of return and describe how to calculate both 

in Excel and how to overcome calculation issues associated with both; 

 

 Discuss the issue of capital rationing and describe how to use the profitability index measure to 

rank projects; and 

 

 List Excel’s five depreciation calculation methods. 

Introduction to Capital Budgeting 
While capital assets comprise a smaller percentage of the total asset portfolio of many businesses, capital 

assets are long-lived. If an organization makes a mistake in acquiring a capital asset, it must live with the 

results of its decision for a number of years. Capital budgeting refers to the process of identifying, 

evaluating, and selecting capital assets or projects and the post acquisition evaluation of capital projects. 

This section of the course focuses on properly evaluating and selecting suitable capital projects. It will 

briefly cover cash flow analysis versus accounting income evaluation methods, differentiate between real 

and nominal cash flows, and discuss how to compute an organization’s cost of capital. Later in this section, 

the focus shifts to  generally accepted techniques for evaluating capital projects followed by a discussion 

of how to deal with capital rationing. 

Cash Flows versus Accounting Income 
Using cash flows instead of accounting income in the evaluation of capital projects is a generally accepted 

practice in corporate budgeting. Incremental cash flows should be discounted at the cost of capital to 

determine the net present value of the project. Make sure to use incremental cash flows in the analysis and 

to recognize any investment in working capital resulting from the project. An incremental cash flow is one 

that would not exist if the project is not accepted. 

42



Page 37 of 94 
      

Copyright © 2016, K2 Enterprises, LLC. 
Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

Here is a simple example of the problem caused by discounting accounting income instead of incremental 

cash flows. 

A project costs $10,000 and is expected to last for two years, producing cash income of $7,500 and $2,500. 

The cost of the project can be depreciated at $5,000 per year. The cost of capital is 10%. Compare the NPV 

calculated using cash flows versus the NPV calculated using accounting income. Ignore all tax effects. 

Note from 

this 

analysis that using accounting income rather than incremental cash flows distorts the selection decision. 

While using accounting income returns a positive NPV, using incremental cash flows returns a negative 

NPV, indicating that the project is unacceptable given the cost of capital. Accounting income results in a 

higher NPV because the cash outflows associated with the acquisition of the project are recaptured as 

depreciation over the useful life of the asset. In other words, the cost of acquisition is postponed into the 

future. 

Nominal Versus Real Cash Flows 
The most common mistake made by most accountants and business professionals in evaluating and 

selecting capital projects is inconsistency in handling the effects of inflation on the incremental cash flows 

and choice of discount rate. Real dollars are constant dollars:  the effect of inflation is not explicitly 

accounted for in the cash flows. Nominal dollars include the effects of inflation. 
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Here is a simple example to help make the point. 

A project is expected to generate real cash flows of $5000 in years one and two. What nominal cash flows 

are generated by the project if the expected inflation rate is 3%? 

 

 

 

 

Note from the analysis above that the nominal cash flows have been inflated at a rate of 3% per year. The 

nominal cash flows in Year 1 amount to $5,000 x 1.03, totaling $5,150. The nominal cash flows in Year 2 

amount to $5,000 x 1.032, totaling $5,305. 

To maintain consistency in your project evaluations, just follow these simple rules. 

 Use real discount rates with real cash flows. 

 Use nominal discount rates with nominal cash flows. 

If inflation is handled consistently in evaluating capital projects, it doesn’t matter whether real dollars or 

nominal dollars are used. The calculated NPVs and IRRs will be the same. At low rates of inflation, a real 

rate can be approximated by subtracting the inflation rate from the nominal rate. In other words, if the 

nominal rate is 9%, and the expected inflation rate is 2%, then the real rate would be approximately 7% 

(9% – 2%). As the inflation rate goes up, a formal calculation should be used to compute the appropriate 

rate, whether real or nominal.  

The formulas to use in converting real rates to nominal rates and vice versa are shown here. 

 

 

 

Following is an example to prove the similar result of NPVs computed using nominal rates with nominal 

cash flows and real rates with real cash flows. 

A company owns a lease that will cost $24,000 per year, increasing at 2% per year over the next four years. 

The lease payment is due in advance at the beginning of each year. The increased lease cost is equal to the 

expected inflation rate over the four year period. If current discount rates are 10%, what is the present value 

of the lease? 

Nominal Rate = (1+ Real Rate) x (1+ Inflation Rate) – 1 

Real Rate = (1+ Nominal Rate) / (1+ Inflation Rate) – 1 
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One of the most common errors when accounting for inflation in capital budgeting is using real cash flows 

with a nominal discount rate. This inconsistency in the treatment of inflation creates a bias against the 

selection of worthwhile projects because the discounted cash flows will be understated and result in a lower 

NPV. 

Cost of Capital 
Now that we have investigated the impact of inflation on cash flow, let’s turn our discussion to the choice 

of discount rate. The rate at which cash flows are discounted should equal the company’s cost of capital. 

What, however, is the cost of capital? Is it the short-term or long-term borrowing rate? Is it the average 

return on the stock market  or the return expected by the shareholders at the time they invested in the 

company?  

Actually, the appropriate rate of return is a combination of all of these and other factors. The company’s 

cost of capital is often referred to as the weighted average cost of capital (WACC). The WACC is the 

discount rate used for discounting cash flows in calculating NPV; it also represents the required rate of 

return when using IRR. 

The weighted average cost of capital represents the long-term, after-tax average cost of using funds, whether 

borrowed or invested by shareholders in the company. In its simplest form, WACC is the combined cost of 

debt and equity used by the business.  

The cost of debt capital is represented by the average interest rate on long-term borrowings. The cost of 

long-term borrowings is used because the assets being acquired are capital assets; they will have a useful 

life greater than one year. Debt capital also has tax benefits. Because interest paid on debt is tax deductible, 

the true cost of debt capital will be net of any tax benefits. The tax benefit is equal to the marginal tax rate 

of a company times the amount of interest paid on debt. If the tax rate of a company is 30%, and the average 

cost of long-term debt is 6%, then the after-tax cost of debt capital is 4.2% (6% x (1-30%)). 

The cost of equity capital, including retained earnings, is more difficult to estimate. To begin with, there is 

no tax advantage because dividends paid are not tax deductible by a company.  
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To estimate the cost of equity capital, most companies attempt to apply the principles of the capital asset 

pricing model (CAPM). The CAPM holds that interest is a function of risk. Risk is defined as variability or 

fluctuation in earnings. More variability means greater risk. The risk of an individual company can be 

measured by the variability of its returns over time relative to the variability of the returns of the entire 

stock market. That relationship is often referred to as beta (ß), which is a measure of market or systematic 

risk. 

 A beta of 1 means that a company has risk equal to the stock market as a whole. 

 A beta that is greater than 1 means that a company has greater risk than the market as a whole. 

 A beta of less than 1 means that a company has less risk relative to the market. 

Beta can be seen as the tendency of a company’s returns to respond to changes in the market. A beta of 1.3 

means that a company’s earnings are 30% more volatile than the market. In other words, if the stock market 

went up $1, then the company’s stock price would increase by $1.30. Likewise, if the market went down 

by $1, the company’s stock price would decrease by $1.30. 

What does this have to do with the cost of equity? CAPM states that the cost of equity is equal to the risk-

free rate of return plus the risk premium associated with an individual company. The risk-free rate of return 

is generally accepted to be the average return on 10-year Treasury Inflation Protected Securities (TIPS) 

bonds. 

The risk premium for an individual company is equal to the risk premium for the stock market as a whole 

times the beta for the company. The risk premium for the stock market represents the extra return that the 

stock market must provide over the risk-free rate to compensate investors for market risk. In other words, 

if the risk-free rate and the average return on the stock market are known, and a company’s beta can be 

estimated, then the cost of equity capital for a specific company can be estimated. That is the rate that would 

be used in calculating WACC. 

The cost of equity capital can be estimated using the following formula. 

ke = ß(Rp) + Rf 

ke  =  cost of equity capital 

ß   =  company beta 

Rp =  risk premium 

Rf  =  risk-free rate 

The next step is to get estimates of the variables included in the formula. The risk-free rate is accepted to 

be the 10-year TIPS rate. The real return on TIPS bonds is currently estimated to be 2%. The long-term real 

return on equities is estimated to be between 4% and 5%. (Some economists estimate the average long-term 

return to be as high as 7%.)  That means the risk premium ranges from 2% (4% - 2%) to 3% (5% - 2%). 

Publicly traded companies can get their beta from a number of readily accessible sources. If a company is 

not publicly traded, then beta must be estimated. Below is an example to illustrate how to calculate the real 

cost of equity. 
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The average real return on the stock market is 5%, and the average real return on 10-year TIPS is 2%. The 

company is traded on NASDAQ and has a computed beta of 1.5. Compute the risk premium for all equity 

securities and the real cost of equity capital for the company. 

 

Once the cost of long-term debt and the cost of equity are estimated, only one more piece of information is 

required to compute WACC: the capital structure of the company. Capital structure refers to the percentage 

of long-term debt and equity used to finance the company. In this case, the planned capital structure is more 

important than the actual capital structure. To calculate WACC, simply add 1) the after-tax cost of long-

term debt times the percentage of debt in the capital structure to 2) the cost of equity times the percentage 

of equity in the capital structure. 

Following is a simple example of calculating the weighted average cost of capital. 

A company estimates its average real cost of long-term debt to be 6.5%, and its real cost of equity to be 

7%. The company maintains a debt-to-equity ratio of .67. In other words, its capital structure is 40% debt 

and 60% equity, made up of 50% retained earnings and 50% common stock. The marginal tax rate of the 

company is 30%. Calculate the weighted average cost of capital. 

 

Average Real Return on Stock Market R me 5.0%

Average Real 10-Year TIPS Rate R f 2.0%

Risk Premium R p R me  - R f 3.0%

Risk Index or Beta ß 1.5     

Real Cost of Equity Capital k e ß(R p ) + R f 6.5%

Real Cost of Capital

Equity k e 7.00%

Long-Term Debt R d 6.50%

Tax Rate t 30%

Real After-Tax Cost of Capital

Equity k e 7.00%

Long-Term Debt k d R d (1 - t) 4.55%

Capital Structure

Equity w e 60%

Long-Term Debt w d 40%

WACC k w d (k d ) + w e (k e ) 6.02%
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In this case, the cost of all equity capital, including common stock and retained earnings, was assumed to 

be the same. Quite often, common stock has a slightly higher cost of capital than retained earnings because 

of the issuance costs of common stock. If that were the circumstance in this example, retained earnings 

would occupy a separate layer in the calculation with their own unique cost of capital as would common 

stock and preferred stock if the company issued preferred shares. For every capital source with a different 

cost of capital, simply include a separate layer for each one in calculating the weighted average. 

Remember, one of the more common mistakes in capital project evaluation is using a nominal discount rate 

with real, constant dollar cash flows. If real cash flows are used, make sure to adjust your nominal discount 

rate for inflation.  

The formula for converting nominal rates to real rates was presented earlier in this section. In addition, 

don’t overlook the propensity to mix nominal and real rates in calculating the cost of capital. The simple 

rule is to be consistent! 

Evaluating Capital Projects 
John Graham and Campbell Harvey of Duke University conducted a comprehensive investigation of the 

capital budgeting practices of American companies in 2001. Their findings were published in the Journal 

of Financial Economics (Vol. 60, 2001) and summarized in the Journal of Applied Corporate Finance (Vol. 

15, Spring 2002). The following findings are summarized from their research. 

 Nearly 75% of respondent CFOs reported using Net Present Value (NPV) to evaluate projects. 

Slightly more than 75% reported using Internal Rate of Return (IRR). 

 Larger companies were more likely to use NPV. 

 Highly leveraged companies were more likely to use NPV and IRR than companies with low debt 

ratios. 

 Highly leveraged companies were more likely to use simulation and sensitivity analysis in evaluating 

capital projects. 

 Companies used hurdle rates and the payback method most frequently after NPV and IRR. 

 Over 73% of respondents used the capital asset pricing model (CAPM) for estimating the cost of 

capital. 

 Larger companies and highly leveraged companies were more likely to use CAPM for estimating 

the cost of capital. 

 Nearly 60% of respondents used a single corporate-wide discount rate, even when some projects 

were identified as projects with greater risk. 

As indicated above, there are numerous methods that accountants and business professionals can use to 

evaluate the suitability of proposed capital projects. Among the most popular are NPV, IRR, Payback, 
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Discounted Payback, and simulation. The research indicates that nearly 60% of CFOs still use the payback 

method, although it is largely discredited in contemporary business literature.  

The payback method does not take into account the time value of money, and it does not include the impact 

of cash flows beyond the cutoff date. The discounted payback method overcomes one of these problems by 

accounting for the time value of money. Payback’s popularity can be partly attributed to its simplicity of 

application. However, Graham and Harvey point out that the payback method provides useful information 

to companies with severe capital constraints. In those companies, projects must return a positive cash flow 

early. If not, a company may not have funds available to take advantage of more promising investments as 

they arise in the near-term future, or worse, it may fail. This section will cover the widely used methods for 

project evaluation, NPV and IRR. Both are discounted cash flow methods, but they are different in 

application. 

Net Present Value 
Net present value (NPV) is the second most widely used method for evaluating capital projects. It is a 

discounted cash flow technique. If the weighted average cost of capital is used as the discount rate, NPV 

represents the potential increase in the value of the company produced by accepting the project. 

NPV, as with all discounted cash flow methods, is sensitive to the discount rate used. If the perceived risk 

of proposed capital projects is about average for the company, the discount rate used should be the cost of 

capital, WACC. If the project has more risk associated with it than the average project, a risk adjusted 

discount rate should be used. In other words, as perceived risk increases, the required rate of return should 

increase. The cash flows for a project with above average risk should be discounted at a higher rate. As the 

discount rate increases, NPV decreases, and the likelihood of acceptance decreases.  

Some organizations use three or four general-risk categories, such as very high, high, average, and low, 

each with its own preassigned risk premium. Each project is ranked as to risk, and the rate assigned to that 

category is used as the required rate of return for computing NPV or is used as the hurdle rate when using 

IRR. 

All cash flows, direct and indirect, should be included in a capital budgeting analysis. Quite often, working 

capital required by the project is left out of the calculations. Another item that is often incorrectly accounted 

for is the tax effects of depreciation. The problem only occurs when real dollar analysis is used. Since 

depreciation is based on the nominal cost of an asset at acquisition, depreciation is always stated in nominal 

dollars. If you are using a real dollar analysis, make sure to reduce the tax savings by the compounded 

inflation rate over the useful life of the asset. 

This example uses NPV for evaluating the suitability of a capital project. The inflation rate is assumed to 

be 2%, and the real WACC is 6%. All amounts are stated in real dollars, except depreciation, which is stated 

in nominal dollars. Note the inclusion in the analysis of the project’s working capital requirements and the 

reduction of the tax benefit over the life of the asset. Since the NPV is positive, the proposal is an acceptable 

project. 

49



Page 44 of 94 
      

Copyright © 2016, K2 Enterprises, LLC. 
Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

 

Internal Rate of Return 
Internal rate of return (IRR) is the most widely used method for evaluating capital projects. It is a discounted 

cash flow technique. If the weighted average cost of capital is used as the hurdle rate, then IRR should lead 

to the same decision as NPV under most conditions. If greater risk is associated with a project, most 

companies will adjust the hurdle rate upward. IRR also requires consistency in the use of real hurdle rates 

with real cash flows and nominal hurdle rates with nominal cash flows. The use of a nominal hurdle rate 

with real cash flows will bias the decision against the project being evaluated. 

IRR is the rate of interest at which the present value of the expected cash inflows from a capital project 

equals the present value of the expected cash outflows of the project. It is sometimes referred to as the time-

adjusted rate of return. Projects with higher IRRs are preferable to those with lower IRRs.  

The IRR represents the rate at which the NPV for a project is equal to zero or the interest rate at which the 

project breaks even. If the IRR is greater than the cost of capital, the project is profitable. 

Several problems are associated with using the IRR as a capital project evaluation technique.  

1. First, all free cash flows are assumed to be reinvested in the project at the computed IRR. If a 

project yields an unusually high IRR, it is unlikely that a company will be able to reinvest at that 

high rate. The modified internal rate of return (MIRR) overcomes this problem. MIRR assumes 
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that free cash flows generated by a project are reinvested at the company’s cost of capital, just like 

NPV. Of course, reinvestment at the company’s cost of capital is a much more likely scenario.  

 

2. Second, the calculated IRR may not be unique. In a conventional analysis, where all cash outflows 

occur at the beginning of a project, the calculated IRR is unique. In projects where cash outflows 

occur throughout the project, multiple IRRs can be calculated, depending on the seed rate used to 

make the calculation. No one has devised a way to determine which IRR calculated under these 

conditions is the correct one to use in the evaluation.  

 

3. Third, IRR cannot handle a situation where the cost of capital is expected to change over the life of 

a long project. If NPV is being used, cash flows can be discounted at different rates to deal with 

this problem.  

 

4. Fourth, since the IRR is a percentage interest rate rather than dollars, a group of individual projects 

cannot be easily evaluated as a group. In other words, the IRRs of the individual projects cannot be 

added together to get a composite IRR for the group. A composite NPV can be easily computed by 

adding the NPVs of the individual projects together. 

Here is a simple example of using IRR and MIRR to evaluate a project using the same data as the previous 

NPV example. Again, all cash flows are in real dollars. The tax benefit is reduced at the compounded rate 

of inflation over the project’s useful life, and the effect of the working capital requirements is included. 

Since the project is of average risk, the hurdle rate is the WACC. A self-checking formula tests whether the 

NPV is equal to zero at the IRR. If that test fails, then there is an error in the analysis. In this case, both the 

IRR and MIRR are greater than WACC; hence, the proposal is an acceptable project. 

 

Note that the analyses in both of the project evaluations using NPV and IRR did not explicitly include the 

impact of financing on the cash flows. In conventional capital project evaluation, investing and financing 

are treated as separate issues. In these examples, the evaluations were to determine whether to invest in the 

projects. Financing was implicitly taken into account by using the cost of capital to discount the cash flows.  

Only after a company has accepted a project does financing play a role. If a company manages its capital 

structure consistent with its long-term intentions which were used in calculating WACC, it doesn’t matter 

how an individual project is financed. Including the effect of financing on cash flows in the calculation of 

NPV or IRR is a common mistake. This practice results in a form of double-counting that invalidates the 

analysis. 
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Using Excel in Capital Budgeting 
Excel has a full range of financial functions for determining the suitability of capital projects and other 

investment opportunities. Among them are NPV, XNPV IRR, MIRR, and XIRR.  

Excel’s Present Value Functions 
NPV calculates the net present value of a series of future periodic cash flows discounted using a specified 

discount rate. By default, all cash flows take place at the end of the period. The syntax for NPV follows. 

NPV(discount rate, value1, value2, ...value254) 

The discount rate is the rate of discount over the length of one period. 

The arguments value1, value2, ...value254 represent the future cash flows.   

The values must be equally spaced in time and occur at the end of each period. 

In those cases where cash flows occur at uneven intervals, use Excel’s XNPV function instead of NPV. 

XNPV calculates the net present value of a stream of cash flows that does not necessarily occur at the end 

of each period. The syntax for XNPV follows. 

XNPV(rate, values, dates) 

The rate is the rate by which Excel will discount all cash flows. 

The values are the cash flows that correspond to a payment schedule. The first value is optional and 

corresponds to a cost or payment that occurs at the beginning of the investment. Excel discounts all 

succeeding payments based on a 365-day year. The series of values must contain at least one positive value 

and one negative value. 

The dates are the dates that correspond to each of the cash flow values evaluated by the XNPV function. 

The first payment date indicates the beginning of the schedule of payments. All other dates must be later 

than this date, but they may occur in any order. 

Many Excel users are familiar with the NPV function, but few have used the XNPV function, so an example 

of XNPV is provided in Figure 37. 
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Figure 37 - XNPV Example 

Excel’s Internal Rate of Return Calculations 
IRR returns the internal rate of return for a series of periodic cash flows. The internal rate of return is the 

rate of interest at which the present value of the expected cash inflows from a capital project equals the 

present value of the expected cash outflows of the project. The syntax of the IRR function is below. 

IRR(values, [irr guess]) 

The values argument is an array or a reference to cells containing the periodic cash flows. 

The irr guess argument is 10%. You can enter another guess if IRR returns the #NUM! error value. IRR 

cycles through the calculations until the result is accurate within 0.00001 percent of the guess. 

MIRR returns the modified internal rate of return for a series of periodic cash flows. The MIRR overcomes 

one of the identified weaknesses of the internal rate of return.  This weakness is the assumption that any 

free cash flow generated by a project reinvests in the project at the calculated rate of return. MIRR alters 

this assumption by allowing users to specify a reinvestment rate for cash flows generated by the project. 

MIRR(values, finance rate, reinvestment rate) 

The values argument represents an array or a reference to cells that contain the periodic cash flows. Values 

must contain at least one positive and one negative value to calculate. 

Finance rate is the rate that you pay on the money used. 

Reinvestment rate is the rate earned on reinvested cash flows. 
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Like XNPV, XIRR calculates the internal rate of return for a series of cash flows that occur at irregular 

intervals. The syntax for XIRR follows. 

XIRR(values, dates, guess) 

The values argument represents the cash flows that correspond to a payment schedule. The first value is 

optional and corresponds to a cost or payment that occurs at the beginning of the investment. Excel 

discounts all succeeding payments based on a 365-day year. The series of values must contain at least one 

positive value and one negative value 

The dates argument represents the dates that correspond to each of the cash flow values evaluated by the 

XNPV function. The first payment date indicates the beginning of the schedule of payments. All other dates 

must be later than this date, but they may occur in any order. 

The guess argument is optional. By default, Excel uses a rate of 10%, but users can enter their own guess 

if desired. 

Figure 38 presents an example of XIRR. 

 

Figure 38 - XIRR Example 
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Using Excel to Evaluate Capital Projects 
Now that we understand the basic syntax of the NPV, XNPV, IRR, MIRR, and XIRR functions, let us 

examine how to evaluate a capital project. In this example, a CFO is evaluating the installation of new 

equipment. 

 

Figure 39 - Evaluating Investment Opportunities with NPV, IRR, and MIRR 

The equipment costs $20 million and has a useful life of six years. The company's real weighted average 

after-tax cost of capital (WACC) is an estimated six percent. Over the life of the project, real inflation is an 

estimated two percent. The company uses straight-line depreciation and estimates its tax rate over the life 

of the investment to be thirty percent. The CFO has prepared a preliminary cash flow analysis and has used 

Excel to calculate the project's estimated net present value, internal rate of return, and modified internal 

rate of return as shown in Figure 39. We will briefly examine the full analysis. In the example, all amounts 

represent real dollars, except depreciation, which represents nominal dollars. 

All cash flows, direct and indirect, should be included in a capital budgeting analysis. Quite often, working 

capital required by a project is not part of the calculations. Another item often incorrectly accounted for is 

the tax effect of depreciation. Since depreciation is a nominal cost of an asset at acquisition, depreciation 

represents nominal dollars. If a real dollar analysis is used, the calculation of tax savings resulting from the 

depreciation of the asset adjusts down by the compounded estimated inflation rate over the useful life of 
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the asset. The example used here incorporates the project’s working capital requirements and the reduction 

of the tax benefit over the life of the asset. 

Net present value (NPV) is the preferred method for evaluating capital projects. If the discount rate is the 

weighted average after-tax cost of capital, NPV represents the potential increase or decrease in the value of 

a company produced by accepting a project. NPV, as with all discounted cash flow methods, is sensitive to 

the discount rate used. If the perceived risk of a proposed capital project is about average for the company, 

the discount rate used should be the cost of capital, WACC. If the project has more risk associated with it 

than the average project, a risk-adjusted discount rate is used. In this case, positive NPV indicates that a 

project is acceptable. 

Internal rate of return (IRR) is the most widely used method for evaluating capital projects. If the weighted 

average after-tax cost of capital is the hurdle rate, then IRR should lead to the same decision as NPV under 

most conditions. IRR is the rate of interest at which the present value of the expected cash inflows from a 

capital project equals the present value of the expected cash outflows of the project. The IRR represents the 

rate at which the NPV for a project is equal to zero or the interest rate at which the project breaks even. In 

this case, the project is acceptable because the IRR is greater than the cost of capital. 

Several problems are associated with using the IRR as a capital project evaluation technique. One is the 

assumption that all free cash flows reinvest in the project at the calculated internal rate of return. If a project 

yields an unusually high IRR, it is unlikely that a company will be able to reinvest at such a high rate. The 

modified internal rate of return (MIRR) overcomes this problem by allowing a user to specify the 

reinvestment rate, usually WACC. In this case, the project is acceptable because the MIRR is greater than 

the cost of capital. 

Capital Rationing 
Quite often, a company is faced with multiple capital project proposals, all of which yield positive NPVs 

or suitable IRRs. Generally speaking, any project with a positive NPV is an acceptable project. If capital 

funding is freely available, rejection of an acceptable project is an irrational decision. Unfortunately, many 

companies artificially limit or cap their capital investment spending. This creates an environment of capital 

rationing where some acceptable projects are rejected in favor of others. Some accounting professionals 

use the profitability index to rank acceptable projects. The profitability index of a project is calculated with 

the following formula. 

Profitability Index = 1+ (NPV / Cost) 

A project with a higher profitability index, ceteris paribus, is better than a project with a lower index. Use 

caution when using the profitability index to rank projects in an environment of capital rationing because 

the index masks the magnitude of each investment. Mechanically choosing projects with the highest indices 

may result in a reduction of value to the company. 

Here is an example to illustrate the problem. In this example, Project B and Project D are mutually 

exclusive. In other words, choosing Project B precludes a choice of Project D and vice versa. Capital 

projects are limited to a total of $5,000,000. Choose the group of projects that maximizes value to the 

company without going over the spending limit. 
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As this example illustrates, to maximize value to the company, one must maximize NPV within spending 

constraints. Between the mutually exclusive projects, Project B is a better investment than Project D. 

However, the selection of Project B forces the selection of several projects that are inferior to Project D, to 

the detriment of the company. While the total profitability index is larger for Selection Group 1, the total 

NPV of the group is less than Selection Group 2. By choosing Selection Group 1, the company forgoes an 

additional $244,000 of NPV for the same investment. That’s because the profitability index masks the 

magnitude of the costs and NPV of each individual project. Simply maximizing NPV within the limits of 

the spending constraint always results in the best decision. 

Depreciation Functions in Excel 
Excel provides several depreciation calculation functions designed to assist in calculating depreciation in 

budgeting and other financial reporting models. Each of Excel’s depreciation functions and related syntax 

is outlined below. 

VDB – Variable Declining Balance Method 
This function returns the depreciation of an asset for any period you specify, including partial periods, using 

the double-declining balance method or some other method you specify. VDB stands for variable declining 

balance. 

= VDB (cost, salvage, life, start period, end period, factor, no switch) 

DB - The Fixed-declining Balance Method 
This function returns the depreciation of an asset for a specified period using the fixed-declining balance 

method. 

= DB (cost, salvage, life, period, month) 

DDB - The Double-declining Balance Method 
This function returns the depreciation of an asset for a specified period using the double-declining balance 

method or some other method you specify. 

= DDB (cost, salvage, life, period, factor) 
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SLN – Straight Line Method 
This function returns the straight line depreciation of an asset for one period. 

= SLN (cost, salvage, life) 

SYD – Sum-of-the-Years Digits Method 
This function returns the sum-of-the-year’s digits depreciation of an asset for a specified period. 

= SYD (cost, salvage, life, period) 
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Miscellaneous Techniques Used in Creating Pro Forma 

Statements 
Ultimately, after all of the input has been collected and processed, after all of the forecasts and regressions 

have been made, after all of the value of the resources has been maximized, a set of pro forma financial 

statements is usually produced as an output of the budgeting process. These typically contain a balance 

sheet, an income statement, and a statement of cash flows.  Because these pro forma financial statements 

are subject to revision many times over during the budget cycle, it is imperative that they are built and 

maintained to accommodate seemingly countless iterations and revisions. 

Learning Objectives 
Upon completing this section, you should be able to: 

 List four best practices for addressing spreadsheet design issues; 

 

 Describe how to adjust budgets for seasonal fluctuations and how to allocate and back-fill budget 

estimates by days; 

 

 Utilize Excel’s Watch Window feature to monitor budget results; 

 

 Describe how to create VLOOKUP formulas; 

 

 Describe how to link workbooks, including using defined names to establish links and why that is 

important; and 

 

 Explain how to accommodate circular reference formulas in Excel. 

Defining Budget Assumptions and Other Spreadsheet Design Issues 
While the overall format of these statements will vary from company to company based on such factors as 

industry, number of periods, and individual preferences, there are fundamental issues that are central to 

virtually all projected financial statements.  When assimilating all of the relevant inputs and building the 

projected financial statements, users should be cognizant of issues such as: 

 Documenting and labeling assumptions, 

 Clearly labeling assumptions for input, 

 Not embedding assumptions into formulas, and 

 Building error-checking routines into formulas. 
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Though clearly not meant to be an all-inclusive listing, the items presented above represent four of the key 

issues associated with sound spreadsheet design; each of these items is discussed in detail in the following 

sections. 

Documenting and Labeling Assumptions 
Virtually all spreadsheets contain assumptions, and budgeting spreadsheets generally contain a significant 

number of assumptions.  Examples include projected accounts receivable collection periods, projected 

amounts of inventory on hand, and projected interest rates.  In order to simplify the budgeting process to 

the extent possible and to enhance the overall accuracy of the pro forma financial statements, it is imperative 

that assumptions be clearly documented and labeled.  Two techniques to assist with this process include 

placing all assumptions on a separate worksheet and using comments to document assumptions. 

In the example presented in Figure 40, a separate worksheet has been created on which all assumptions 

feeding into the pro forma financial statements are placed.  In this case, the assumptions are separate for 

each month, thereby accommodating any seasonal trends in the business and/or projected growth or 

contraction. 

 

Figure 40 - The Assumptions Worksheet in a Budgeting Workbook 

Notice also in the previous example, a comment has been included to assist in documenting the worksheet.  

In this case, George Washington inserted a comment to document why the January collection period is 42 

days.  Comments can be inserted in a number of ways, including simply by right-clicking on the desired 

cell and selecting Insert Comment from the resulting menu. 

A key point to consider when using comments to document budget assumptions include not just the simple 

ability to insert comments into worksheets, but also how the comments appear in the worksheets.  As shown 

in Figure 41, in the Advanced group of Excel’s Options, users can control whether comments are always 

visible on the worksheet, visible only when the mouse hovers over the cell in which the comment resides, 

or are never visible. 
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Figure 41 - Controlling How Comments Appear in an Excel Worksheet 

In addition, users should address how Comments appear when worksheets are printed. As shown in Figure 

42, by clicking the Page Setup dialog launcher on the Page Layout tab of the Ribbon and then clicking 

on the Sheet tab of the Page Setup dialog box, users can control whether comments print at all, print on a 

separate page apart from the worksheet, or print as displayed on the worksheet. As a practical matter, most 

users find printing on a separate page at the end of the worksheet to be the best choice in most circumstances. 
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Figure 42 - Controlling How Comments Print 

Clearly Labeling Assumptions for Input 
To assist in ensuring the accuracy of the pro forma financial statements, clearly label assumptions for input. 

You can use visual indicators and input aids such as shading cells and creating Data Validation rules to 

accomplish this objective. The use of visual aids such as shading cells can be very effective at alerting users 

to cells requiring input as shown in Figure 43. Here, the shaded cells are those requiring input; those not 

shaded are protected, and input is not allowed. 
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Figure 43 - Using Cell Shading to Indicate Input Cells 

In addition, to ensure the entry of correct and valid data, spreadsheet designers may establish Data 

Validation rules and prompts. As shown in Figure 44, Data Validation allows users to create rules and 

prompts regarding the data entered into a cell. In the example presented, Data Validation prompts users to 

enter income tax payments and to enter these amounts as negative numbers. Of course, if a user enters an 

amount that does not meet the criteria established in the Data Validation rule, an error message appears 

prompting the user to enter a value in the correct range. 

 

Figure 44 - Using a Data Validation Rule to Prompt User Input 
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Never Embed Assumptions in Formulas 
There are at least two potential problems associated with embedding assumptions into formulas. First, if an 

assumption is embedded into a formula, the assumption will not appear explicitly on any report. For 

instance, when printing a projected balance sheet, if the relevant assumptions are embedded into the formula 

calculating accounts receivable, then, when the report is printed, it will not be apparent what the accounts 

receivable collection period is. On the other hand, if the assumptions are discretely entered and displayed 

elsewhere and only referenced in the formulas, then it is possible to print the assumptions so that they can 

be reviewed and verified. 

Second, when assumptions are embedded into formulas, changing them becomes more difficult and 

susceptible to error, as the formulas themselves must be modified. However, if the assumptions are listed 

separately on the worksheet and only referenced in the formulas, then when the assumptions need to be 

modified, doing so only requires editing the cells containing the assumptions and not the cells containing 

the formulas. In this case, the cells containing formulas can remain protected, thereby minimizing the 

likelihood that a user will corrupt the formulas. 

Building Error-Checking Routines into Formulas 
It is an unfortunate but indisputable fact – spreadsheets are prone to error, and we must take steps to reduce 

the number of errors that might appear in our budgeting spreadsheets. Tools such as Data Validation are 

beneficial in this effort, but they alone are not enough. Sometimes, we should also modify formulas to 

ensure that they assist us in identifying errors. 

One common technique for doing so is to alert users when financial statements contained in the budget 

model do not balance. For instance, if total assets on the balance sheet do not equal total liabilities and 

equity, an IF statement similar to that pictured in Figure 45 would call a user’s attention to the fact that the 

statements do not balance. 

 

Figure 45 - Using an IF Function to Identify Out-of-Balance Condition 

Conditional formatting could also be useful in testing for the condition identified above by the IF statement. 

For instance, the conditional formatting rule shown in Figure 46 examines the content of cell B5 from 
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Figure 45. If the content of the cell is “ERROR – NOT IN BALANCE” – the phrase inserted by the formula 

shown in Figure 45 – then the conditional formatting rule causes cell B5 to format with a red background 

and white text, calling even more attention to the out-of-balance condition. 

 

Figure 46 - Conditional Formatting Used to Identify Out-of-Balance Condition 

Excel 2007, 2010, and 2013 contain an IFERROR function that can be useful in trapping errors in formulas. 

For instance, such a report can be useful at trapping “division by zero” errors that appear in budget versus 

actual financial statements when a zero appears in the “budget” column of the statement and a non-zero 

value appears in the “actual” column of the same statement. As shown in Figure 47, IFERROR tests to 

determine if the formula immediately following the IFERROR command will return an error. If so, Excel 

substitutes the value immediately following the formula for testing for the formula result; if not, then the 

result of the formula is recorded into the cell. In the specific example presented in Figure 47, because the 

budget amount for Amortization was zero, in the absence of an IFERROR formula, the percentage variance 

calculation would normally have returned a #DIV/0! error message. With the presence of the IFERROR 

formula, Excel recognized that an error would have been returned by the D7/B7 operation within the 

formula and, therefore, Excel substituted zero in lieu of the #DIV/0! Error message. 
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Figure 47 - Using IFERROR to Trap Potential Errors in Worksheets 

Adjusting for Seasonal Fluctuations 
Seasonal fluctuations in revenues and expenses are the norm for a number of businesses. Retailers, for 

instance, recognize approximately 40% of their annual revenues during the Christmas shopping season. 

Wholesalers supplying these retailers accumulate a substantial portion of their annual revenues during the 

late summer and early fall, selling products in anticipation of the Christmas shopping season. Likewise, ski 

resorts earn a substantial portion of all revenues and profits from the middle of December through the end 

of March. Cruise lines, on the other hand, realize most of their revenues during the summer vacation season.  

Clearly, seasonal fluctuations in revenues and expenses are common in many businesses. Failing to account 

for these fluctuations in the budgeting and forecasting process can lead to errors in projecting cash flows 

and planning for resource requirements and allocations. 

Businesses that experience significant seasonal fluctuations tend to experience the same seasonality pattern 

year-after-year. This fact makes incorporating seasonality into the budgeting and forecasting cycle much 

easier than if the fluctuations occurred randomly. By relying on historical patterns, it is relatively easy to 

account for seasonal fluctuations in both revenues and expenses.  

When preexisting patterns exist, users can apply weighting factors calculated from prior years to projected 

totals for the current year to account for seasonality. In this example, historical information is used to 

compute relative percentages of sales for each month as shown in Figure 48. These percentages are then 

applied to projected total sales for the following year to generate projected revenue by month. 
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Figure 48 - Calculating Monthly Percentage Weights Applied to an Annual Revenue Projection 

In the previous example, seasonal fluctuations were incorporated into the monthly revenue forecasts by 

multiplying the projected annual sales for the coming year by monthly weighting percentages developed 

from the prior year. In this example, the annual fixed expenses (taxes and maintenance fees) are allocated 

to the individual months based on the average annual occupancy rate of the vacation condos for the 

proceeding three years, as shown in Figure 49.  
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Figure 49 - Allocating Fixed Expenses Based on Occupancy Rate 

Allocating and Back-Filling Estimates by Days 
As demonstrated in the previous section, it is quite common for organizations to forecast revenues and 

expenses at annual levels but then to allocate or back-fill these annual forecasts to shorter time periods. In 

many cases, this is done by simply dividing the annual forecast by twelve in order to generate monthly 

targets. Monthly estimates calculated in this manner are often sufficiently accurate for most budgeting and 

forecasting applications. However, in some instances – for example, when monthly revenue forecasts are 

used as targets in computing incentive compensation for sales staff – a higher degree of accuracy is needed. 

Simply dividing estimated annual revenues by twelve results in monthly targets based on an average of 

30.416 sales days per month (365/12). Alternatively, annual sales could be allocated with greater precision 

based on the number of sales days in each month as shown in Figure 50. 
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Figure 50 - Allocating Revenues Based on the Number of Days in Each Month 

In this example, the CHOOSE function is used in conjunction with the MONTH, YEAR, and MOD 

functions to specify the number of days in each month. Forecasted annual revenue is then spread across 

months based on the number of days in each month relative to the number of days in the year.  

Does this added precision warrant the additional calculational complexity? In this case, the amount of 

revenue projected for February using the more precise method is less than what would have been estimated 

by dividing forecasted annual revenues by twelve. This difference may introduce substantial error in the 

process of determining whether sales targets in February were achieved. 

Monitoring Results with the Watch Window 
Excel’s Watch Window can prove to be a tremendously valuable tool when building budgeted financial 

statements. The Watch Window allows a user to monitor the results in one or more cells – cells either in 

the same workbook or in other workbooks – as changes are being made to other cells. Thus, in a budgeting 

environment, as changes are made to assumptions, a user can immediately see the impact those changes 

have on net income and ending cash, for instance, without having to navigate to those cells. 

To use Watch Window, navigate to the Formulas tab of the Ribbon and click Watch Window to open the 

Watch Window. In the Watch Window, click Add Watch… to open the Add Watch dialog box. In the 

Add Watch dialog box, indicate the cell(s) you wish to monitor in the Watch Window and select Add as 

shown in Figure 51. 
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Figure 51 - Setting Up a Watch Window 

Upon clicking Add the cells to the Watch Window, it appears as shown in Figure 52. 

 

Figure 52 - A Watch Window in Excel 

Of note, you can “dock” the Watch Window by clicking and dragging it above, to the left of, to the right 

of, or below the worksheet window. In the example shown, a user docked the Watch Window to the left of 

the worksheet window so that she could monitor the impact of changing budget assumptions on budgeted 

net income for the upcoming twelve months. 

70



Page 65 of 94 
      

Copyright © 2016, K2 Enterprises, LLC. 
Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

 

Figure 53 - Docking the Watch Window for Easy Visibility of Key Budget Results 

Performing Lookups with VLOOKUP 
The VLOOKUP and HLOOKUP functions provide users with the ability to locate information in Excel 

lists and to return corresponding values from that list. These two functions operate identically with the 

exception of the orientation of the referenced list. The VLOOKUP function works with lists arranged 

vertically, while the HLOOKUP function works with lists arranged horizontally. Because most accounting 

professionals arrange data in vertical rather than horizontal lists, the VLOOKUP function is used more 

often than the HLOOKUP function; therefore, VLOOKUP is demonstrated in this section. 

One way to use VLOOKUP in creating projected financial statements is to assist in identifying remaining 

balances on notes payable (or receivable). For instance, assume an amortization schedule for a note payable 

has been created and is included as a worksheet in a budgeting workbook. Further, assume that the data list 

containing monthly payment, principal, interest, and remaining balance information has a defined range 

name of “amortization.” As shown below, a VLOOKUP function can locate a value from a particular cell 

and return a corresponding value from the data list.   

 

Figure 54 - Using a VLOOKUP Formula on a Budgeted Balance Sheet 

The general format of the VLOOKUP function follows. 

VLOOKUP(lookup_value, table_array, column_index_num, range_lookup) 

In the preceding example, the lookup_value is cell “B4,” which is a date. The table_array is the range name 

“amortization” the column_index_num is “5,” which in effect commands VLOOKUP to return the value 
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from the fifth column of the table_array. The range_lookup is optional; if TRUE or omitted, it means Excel 

searches for an approximate match, and, if FALSE, it means Excel searches for an exact match. With these 

values in place, the VLOOKUP formula in the preceding example searches in the leftmost column of 

“amortization” for the date in cell B4 and returns the corresponding value from the fifth column of the 

range. 

Another way to use VLOOKUP in generating pro forma financial statements would be to assist in tax 

calculations. For example, as shown in Figure 55, multiple VLOOKUP functions can be used to calculate 

income tax due from the table of tax rates displayed. Closer inspection of the formula reveals that multiple 

lookups are required to accommodate the graduated structure of the tax rates. 

 

Figure 55 - Using VLOOKUP to Assist in Tax Calculations 
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Linking Workbooks 
When creating budgeted financial statements, it is often necessary to link data from one workbook to 

another. Most users accomplish this by making formula references to traditional row-and-column addresses, 

such as the one that follows. 

='[Pro Forma Financial Statements.xlsx]Assumptions'!$B$57 

This method works fine until the location of the “source” data changes while the “destination” workbook 

is closed. If that happens, the path in the link to the data no longer works. To solve this problem, use defined 

names to link data from one workbook to another. 

What is a defined name? Quite simply, a defined name is nothing more than a nickname or alias for a cell 

or range of cells. Say, for instance, cell B6 contains total budgeted revenue data for a company on its income 

statement. We could continue to refer to that cell based on its traditional row-and-column address of “B6,” 

or we could decide to give it a defined name – a nickname – of “Revenue” (or almost any other name we 

desired). Once we assign a defined name to a cell or range of cells, we can use the defined name virtually 

any place where we would otherwise use a traditional row-and-column address, including as a reference in 

multi-workbook environments. 

There are a few rules to remember when creating a defined name. Though not intended to be a complete 

listing, the following bullet points summarize the major rules related to creating defined names. 

 Defined names can contain letters and numbers but not spaces or special characters such as 

punctuation marks. 

 Defined names cannot begin with a number. 

 Defined names must be 255 characters or less in length. 

 Defined names cannot be a combination of letters and numbers that could otherwise be a row-and-

column address. Thus, “A100” cannot be a defined name because that is a valid row-and-column 

address in Excel. 

Creating Defined Names 
You can create defined names using a number of methods. The simplest and easiest way to do so is to select 

a cell or cells, click in the Name Box, and enter the defined name directly in the Name Box as shown in 

Figure 56. 
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Figure 56 - Creating a Defined Name in Excel's Name Box 

Additionally, you can create a defined name by selecting Define Name from the Defined Names group on 

the Formulas tab of the Ribbon to open the New Name dialog box. Enter the Name and cell address to 

which the name refers as shown in Figure 57. You can also access the New Name dialog box by selecting 

New from the Name Manager in the Defined Names group of the Formulas tab of the Ribbon. 

 

Figure 57 - Creating a Defined Name in Excel's New Name Dialog Box 
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Excel can also create defined names from labels in adjoining columns or rows. To use this method, select 

the appropriate range of data, including the rows or columns containing the labels, and select Create from 

Selection in the Defined Names group of the Formulas tab of the Ribbon. This method provides a very 

fast way of creating multiple defined names simultaneously. 

As stated previously, once we create a defined name, we can use it anywhere we would otherwise use a 

traditional row-and-column address. Thus, returning the formula shown previously in this section, if we 

had assigned the defined name “Expenses” to cell B57, we could use that name to link that data to another 

workbook as shown below.   

='[Pro Forma Financial Statements.xlsx]Expenses 

However, if we construct the links between workbooks based on defined names instead of row-and-column 

addresses, then the integrity of the data remains intact, even if the location of the data changes within the 

source workbook. This is because a defined name “follows” a cell; thus, if the location of the cell changes, 

the reference to that cell within the defined name changes also. 

Accommodating Formulas with Circular References 
Though it is usually preferable to avoid circular references, they will appear occasionally in preparing pro 

forma financial statements. One common example is in tax accrual calculations, where federal income tax 

is deductible on state tax returns. Here, since federal tax is deductible on the state return, and state tax is 

deductible on the federal return, a circular reference exists by the very nature of the calculation. Another 

example is in attempting to calculate the amount of cash at the end of the month. This, in part, depends on 

interest income. Interest income depends on how much cash is available to invest. Again, a circular 

reference exists by the very nature of the relationships between the variables. 

Formula Auditing functions are often used in Excel to prevent circular referencing formulas from occurring. 

However, it is not always necessary to eliminate these references if users understand why they have 

appeared, what impact they have on the pro forma statements, and how to ensure that the presence of these 

formulas is not affecting the accuracy of the statements. Perhaps the most common way of accommodating 

formulas with circular references is to change the number of iterations calculated by Excel. 

By accessing Excel’s Options and choosing the Formulas tab, users can check the box labeled Enable 

iterative calculation as shown in Figure 58. This will cause Excel to calculate worksheets containing 

circular reference formulas up to the number of times specified in the Maximum iterations field, or until 

the value change in the Maximum change field is reached. Though 100 iterations is the default maximum 

number of iterations and 0.001 is the default maximum change value, usually Excel reaches sufficiently 

accurate results in as few as three iterations. 
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Figure 58 - Enabling Iterative Calculations for Circular References Formulas 
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Budget Reporting Issues and Solutions 
Among the biggest issues facing those who use Excel in budgeting and forecasting applications are 1) how 

to consolidate data from multiple divisions, profit centers, locations, entities, etc. into a consolidated budget, 

2) how to draw readers’ attention to budget variances that require management action, and 3) how to 

facilitate flexible budget-to-actual reporting in Excel, complete with drill down capabilities.  

Learning Objectives 
Upon completing this section, you should be able to: 

 Describe how to consolidate budget data using formulas and Excel’s Data Consolidate feature; 

 

 Implement conditional formatting as a means of analyzing data, including identifying significant 

budget variances; and 

 

 Describe how to work with PivotTables as a comprehensive budget reporting solution. 

Consolidating Data 

Using Formulas for Data Consolidation 
Most accounting professionals routinely face the task of combining or consolidating financial data from 

several worksheets. The task may require consolidating the results of multiple periods, multiple 

departments, multiple divisions, or multiple related businesses. In almost every case, practitioners choose 

to insert a new worksheet to hold the combined or consolidated information and then sum through the 

existing worksheets to produce consolidated totals. 

Generally, a single formula is created and then copied down and across the total worksheet. Extraneous 

totals, such as where blank lines exist in the layout of the individual data worksheets, are then deleted, and 

formatting is applied to complete the report. This method is easily understood, can be applied by most 

moderately experienced users, and is very well suited to those situations where the worksheets being 

summed have identical layouts – column by column, row by row, and cell by cell. If the worksheets do not 

have identical layouts, the common workaround is to add rows and/or columns to one or more of the 

worksheets until the cells align properly. 

While some users may create sum-through formulas using a simple arithmetic formulation (=Sheet1!B15 

+ Sheet2!B15 + Sheet3!B15), a more efficient method is to use the SUM function, if the cells are 

properly aligned. Such a formula would be similar to this one: =SUM(Sheet1:Sheet3!B15).  

Let's examine the process of creating and utilizing sum-through formulas that employ the SUM function. 

Refer to the workbook displayed in Figure 59 as this process is demonstrated. 
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Figure 59 - Forecasted Expenses Workbook 

The workbook has six worksheets – Slidell, Covington, Hammond, Houma, Baton Rouge, and Consolidated 

– that contain forecasted expenses for the upcoming year. The Consolidated sheet will contain the total 

forecasted expenses after we build a sum-through formula and copy it down and across the appropriate 

worksheet range. 

To create the sum-through formula, do the following. 

1. Click on the Consolidated worksheet tab and put the cursor in the upper left-hand corner of the 

data range. In this case, place the cursor in cell C7. 

2. Begin the formula by entering =SUM(. 

3. Next, click on the sheet tab of the first worksheet in the range, Slidell, and then click on cell C7. 

4. Hold down the SHIFT key while clicking on the sheet tab of the last worksheet in the range, Baton 

Rouge, and press ENTER. 

Excel will have entered the following formula: =SUM('Slidell:Baton Rouge'!C7). Now, copy the 

formula down and across the appropriate range and then reformat cells, delete rows, and add totals as 

necessary to complete the worksheet. 

Note the end points of the range of worksheets. In this case, the Slidell and Baton Rouge worksheets act as 

the end points. The end points of the sum-through formula act in similar fashion to the end points of any 

other SUM formula. If you add another worksheet for another store location between the end points, the 

forecasted amounts for the new location will be included in the consolidated totals automatically. If you 

add the new worksheet outside of the end points, the consolidated totals will not include the amounts. Note 

that a user can drag a worksheet outside  the end points to remove its amounts from the consolidated totals 

or drag a worksheet within the end points to include its amounts in the totals. This is a very powerful feature, 

but it can also cause problems for users unaware of this functionality. 

For example, when printing multiple worksheets at the same time, the sheets always print from left to right, 

regardless of the order in which the sheets were selected. In our example worksheet, let's suppose that a 

user wanted to print the Slidell, Baton Rouge, Hammond, and Consolidated worksheets in that order. 
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Seemingly, the way to accomplish that task is to drag the Baton Rouge sheet tab to the left of the Hammond 

sheet tab.  

However, in doing so, the amounts in the Hammond worksheet would no longer be included in the totals 

on the Consolidated worksheet because the Hammond worksheet is no longer between the end points 

identified in the formula. Even experienced Excel users inadvertently fall into this subtle trap when 

dragging sheets to reorder them for printing. In larger workbooks with many sheets, this can be a very 

pernicious problem because users may not recognize the impact on totals immediately. 

A simple solution to this problem is to create dummy worksheets that have no purpose other than to function 

as end points for the sum-through formulas. In other words, create two new sheets, one named Begin and 

the other End, that serve as the end points for the sum-through formulas as shown in Figure 60. 

 

Figure 60 - Using Dummy Worksheets as End Points for Sum-Through Formulas 
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 Using dummy sheets as end points can be very useful in situations where users 

want to report rolling twelve-monthly or quarterly results. The report column 

where the rolling totals are reported would use sum-through formulas employing 

dummy end-point sheets. As the financial results from a new month are copied 

into the workbook, the new sheet is moved between the end points, and the oldest 

sheet is moved outside the endpoints, thereby easily rolling up the previous 

twelve months’ results without creating a new formula. 

 

Working with Excel’s Data Consolidate Function 
The Consolidate command provides an effective way of consolidating financial information, whether 

imported or created in Excel. Using this functionality, we get results similar to sum-through formulas but 

without building or troubleshooting any formulas. In short, Consolidate allows us to summarize our data 

quickly and accurately. Data can be consolidated from within the same worksheet, from other worksheets 

in the same workbook, or from other workbooks. Links to source data can be incorporated to update the 

totals automatically whenever the source data changes. Once the consolidation has been completed, it can 

be edited and consolidation ranges added or deleted. If the data ranges are identical, the data can be 

consolidated by position. If the ranges are not identical, Excel can rely on the column headings and/or row 

labels as cues for determining what cells to sum through. This is termed consolidation by category.  

To begin the consolidation process, create a worksheet on which to place the consolidated data. If the 

worksheets containing the data have identical layouts, consolidate by position, which requires users to copy 

the column headings and row labels to the consolidated worksheet as shown in Figure 61. 

 

Figure 61 - Copying the Column Headings and Row Labels to the Consolidated Sheet 
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To consolidate the income statements, do the following. 

1. Position the cursor in the upper left-hand corner of the consolidation range. In this case, position 

the cursor in cell B9. 

2. From the Data tab, select Consolidate to open the dialog box shown in Figure 62. 

3. Select SUM in the Function drop-down menu. While SUM will be the function used most often, 

there are other functions such as AVERAGE, MINIMUM, MAXIMUM, and STANDARD 

DEVIATION available. 

 

Figure 62 - Using the Data Consolidate Command to Combine Data 

4. From the Reference box, highlight and add each data range, one after the other, to the All 

References box. Highlight the first range on the Retail Division worksheet and click Add, followed 

by the data ranges on the Industrial and OEM Division worksheets. 

5. Since we are combining by position, there is no need to check any of the Use labels in boxes. Check 

Create links to source data so that any changes to the data will flow through to the consolidated 

worksheet. 

6. Click OK to produce the results displayed in Figure 63.  

Note that Outlining is enabled so that the detail of any consolidated row can be expanded by clicking the 

plus sign (+) in the outline symbols on the left. In this case, Cost of Sales is expanded to show the detail 

from the three data worksheets. Try that with a sum-through formula! 
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Figure 63 - Consolidation Results with Outlining Enabled 

Let's review the process. We created a worksheet on which to consolidate the results of three divisions. 

With the cursor in the upper left-hand corner of the consolidation range, we executed the Consolidate 

command, highlighted and added the three data ranges to the Consolidate dialog box, and clicked OK. It's 

easy to see why most users think that this is a superior method when compared to sum-through formulas. 

The consolidation was performed without building or copying any formulas, the consolidations are 

computationally accurate, and users can drill down from the results to see the underlying data. 

In our previous example, the data ranges were identical, so we could consolidate based solely on the relative 

position of the data elements within the data ranges. If the data ranges are not identical, that doesn't preclude 

us from using the Consolidate command. In those circumstances, we must consolidate by category, whereby 

Excel reads the row and/or column labels to determine what data cells should be summed.  

For example, if we were combining expense budgets, and one of several departments had extra accounts, 

we would consolidate by category. Similarly, we would consolidate by category if the order in which the 

data columns were reported was different. To consolidate by category, simply check Top row and/or Left 

column in the Use labels in area of the Consolidate dialog box as shown in Figure 64. 
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Figure 64 - Checking the Appropriate Boxes to Consolidate by Category 

 Note that users can check the Use labels in boxes to automatically create the 

column headings and row labels when performing a consolidation by position. 

However, if the data to be consolidated consists of formal financial statements 

that include blank rows or columns for laying out the report properly, all blank 

rows and blank columns will be treated as a single data element in the final report. 

In other words, all blank rows will be combined into a single blank row, and all 

blank columns will be combined into a single blank column.  

 

The report layout of the resulting consolidation will look different because all of 

the blank rows and columns will be removed. When working with formal reports 

for which you desire to maintain the original layout, copy the column headings 

and row labels to the consolidated sheet as we did in our example and then 

consolidate by position without checking the Use labels in boxes. For this to 

work properly, the individual reports must be identical, or rows and/or columns 

in individual reports must be rearranged until the cells align properly. 
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Using Conditional Formatting to Identify Trends and Significant Variances 
Excel’s Conditional Formatting options can be excellent ways to call attention to significant values, 

variances, trends, and other data in budget-centric reports. Though conditional formatting is not a new 

feature to Excel, this feature is greatly enhanced in versions after 2003. 

Conditional Formatting Basics 

Conditional Formatting Based on Values 
The simplest form of conditional formatting is that based on values. For instance, conditional formatting 

based on values has been applied in the Variance $ column shown in Figure 65. There, any cell containing 

an unfavorable variance greater than $15,000 is automatically shaded and the text displayed in red. 

 

Figure 65 - Conditional Formatting Based on Values 

To apply this conditional format, start by selecting the range of cells from D5 through D18. Then, select 

Conditional Formatting from the Home tab of the Ribbon and choose Highlight Cells Rules followed by 

Less Than to open the dialog box shown in Figure 66. In that dialog box, specify both the criteria for the 

conditional format and the desired format. Click OK to apply the conditional format to all selected cells. 
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Figure 66 - Defining a Conditional Format Rule 

Note that cell references can replace “hard-coded” criteria when creating conditional formats. For instance, 

in Figure 66, the criteria of “-15000” could be replaced by a cell reference of “G3,” thereby allowing a user 

to rapidly change the materiality threshold of the report interactively. Such a change would produce the 

results shown in Figure 67. 

 

Figure 67 - Conditional Formatting Applied with a Cell Reference 

Conditional Formatting Based on Formulas 
In addition to applying conditional formatting based on discrete value inputs, conditional formatting can 

also be applied based on formulas. For instance, formula-based conditional formatting could identify all 
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unfavorable variances exceeding 15% of the budgeted amount. Such a formula might resemble that shown 

in Figure 68. 

 

Figure 68 - Conditional Format Applied with a Formula 

The formula and format specified in Figure 68 will format any unfavorable variance exceeding 15% of the 

budgeted amount with a red background and white text as shown in Figure 69. 
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Figure 69 - Results of a Conditional Format Applied Via Formula 

Because Excel allows report designers to apply multiple conditional formatting rules to the same cells, it is 

possible to “layer” these rules on top of each other. Perhaps in addition to highlighting unfavorable 

variances of greater than 15% in red, management wants to highlight favorable variances of greater than 

5% in blue. To do so, add a second conditional format rule as shown in Figure 70. 
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Figure 70 - Adding a Second Conditional Format 

With the second conditional format in place, the worksheet might now resemble that shown in Figure 71. 

 

Figure 71 - Multiple Conditional Formats Applied to Same Cells 
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PivotTables in Budgeting Environments 
PivotTables are the most powerful feature of Excel, yet many accountants do not use them in their day-to-

day activities. While a complete discussion of PivotTables is beyond the scope of this course, we would be 

remiss if we did not discuss some of the capabilities of PivotTables in budgeting environments. However, 

before we can do so, we should cover some PivotTable fundamentals. 

What is a PivotTable? 
A PivotTable report is an interactive table that automatically extracts, organizes, and summarizes data. A 

PivotTable report can be used to analyze data — for example, to make comparisons, to detect patterns and 

relationships, or to uncover trends. PivotTables are extremely useful for summarizing and analyzing large 

amounts of data efficiently and effectively, including data found in budgeting and forecasting activities. 

Additionally, PivotTables can consolidate data from multiple data sources, easing some of the consolidation 

pains discussed previously. 
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Basic PivotTables 
The power of PivotTables surfaces even while working with basic PivotTables. In our first example, 

consider the budget data presented in Figure 72.  

 

Figure 72 - Sample Budget Data 

You have been tasked with the responsibility of summarizing the data shown in a report that groups the 

budget data by Parent Account; this is an ideal application for a PivotTable. To build a simple PivotTable 

from the columnar data shown, follow the steps outlined below. 

1. Click on any cell in the data range. 

 

2. From the Insert tab of the Ribbon, click PivotTable to open the Create PivotTable dialog box 

pictured in Figure 73. 
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Figure 73 - Create PivotTable Dialog Box 

3. Accept the defaults in the Create PivotTable dialog box and click OK. Upon doing so, Excel inserts 

an outline of the PivotTable on a new worksheet and opens the PivotTable Fields list as shown in 

Figure 74. 

 

 

Figure 74 - Creating a PivotTable in a New Worksheet 
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4. In the PivotTable Field list, click-and-drag each field to the appropriate quadrant in the lower, right-

hand corner of the PivotTable Field list as shown in Figure 75. Notice that as each field is placed 

into a quadrant, the PivotTable updates automatically with the data from that field. 

 

 

Figure 75 - Dragging Fields in the PivotTable Field List 

5. By default, the PivotTable groups and sums each of the accounts based on the Parent Account. 

Notice, however, that each sum is placed at the top of each group; for most accounting 

professionals, this is an unacceptable format. To change the location of the subtotals so that they 

appear at the bottom of each grouping, click the PivotTable Tools Design contextual tab followed 

by Subtotals. Next, select Show Subtotals at the Bottom of the Group as shown in Figure 76. 

Upon doing so, the location of the subtotals changes to match the preferences of most accounting 

professionals. 
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Figure 76 - Changing the Position of PivotTable Subtotals 

6. Another formatting issue easily addressed in the PivotTable is that of the number formats. Users 

can apply any Excel format to the cells in the PivotTable. To do so, simply select a cell, right-click 

to open a context-sensitive menu, select Number Format, and apply the desired format. In most 

cases, this is likely to be either the Accounting Format with the currency symbol or the Accounting 

Format without the currency symbol. 

 

7. At the bottom of the PivotTable, a meaningless Grand Total is present. To disable this Grand Total, 

click the PivotTable Tools Design contextual tab followed by Grand Totals. Then, select from 

the options pictured in Figure 77. 
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Figure 77 - PivotTable Grand Total Options 

8. Another adjustment we will make to this simple PivotTable is to rearrange the Parent Account 

column so that the accounts are no longer in alphabetical order, but, rather, are in an order 

acceptable under generally accepted accounting principles. To do so, simply position the mouse 

pointer on the edge of a cell containing a Parent Account so that the compass rose is visible as 

shown in Figure 78  With the compass rose visible, click, drag, and drop the Parent Account to the 

desired location. Repeat this process for each account you wish to reposition. 
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Figure 78 - Rearranging Accounts in a PivotTable 

9. Lastly, because our PivotTable does not display a Gross Profit calculation, we will add a 

Calculated Item to the PivotTable. Start by selecting a Parent Account cell in the PivotTable, 

select Fields, Items, & Sets from the Analyze tab of the Ribbon and select Calculated Item as 

shown in Figure 79.  

 

 

Figure 79 - Creating a Calculated Item in a PivotTable 
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Selecting Calculated Item causes the Insert Calculated Item dialog box pictured in Figure 80 to open. In 

the dialog box, enter a Name for the Calculated Item and a Formula on which the calculation will be based. 

Finally, click OK to create the Calculated Item. 

 

Figure 80 - Insert Calculated Item Dialog Box 

This simple PivotTable begins to illustrate just some of the power of the PivotTable. Now, let us begin to 

complicate the data set so that it more closely resembles the “real world” and is no longer an academic 

exercise. As shown in Figure 81, a “Location” field has been added to the data set. 

 

Figure 81 - Modified PivotTable Data Set 

Now, retracing the steps previously performed, we create a second PivotTable, except in this instance, we 

add the new Location field as a Filter as shown in Figure 82. 
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Figure 82 - Adding a Filter to a PivotTable 

With the Filter in place, users can easily filter the contents of the PivotTable to one or more locations simply 

by clicking on the drop-down arrow and selecting the Location(s) to include in the PivotTable. 

Alternatively, we can add the Location field to the PivotTable as a Column Label. Upon doing so, the 

PivotTable “pivots” so that it appears as pictured in Figure 83. 

 

Figure 83 - Modified PivotTable with Location as a Column Label 
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Creating Multiple Consolidation Range PivotTables 
Consolidation PivotTables are used to report data that is already tabulated. For example, if a user wants to 

combine divisional or departmental budgeted income statements,  consolidation PivotTables can be used to 

produce the combined reports. The only requirement is that the data layout of the individual worksheets to 

be consolidated is similar, but they need not be identical. 

The icon for Consolidation PivotTables is not available from the Ribbon. Users must add the PivotTable 

and PivotChart Wizard to the Quick Access Toolbar (QAT) or Ribbon to access this functionality.  

In the following example, budgeted product line income statements will be combined into a single report 

with all of the reporting flexibility of a PivotTable. A sample of the data, which has an identical table for 

each of three product lines, is shown in Figure 84.  

 

Figure 84 - Data Summarized Using a Consolidation PivotTable 

Simple Consolidating PivotTables 
In the first dialog box of the PivotTable Wizard, make sure to select Multiple consolidation ranges. Click 

Next. Then, select how the Page fields are to be created. To insure maximum reporting flexibility, choose 

I will create the page fields and then click Next. The dialog box for the next step in the wizard appears as 

shown in Figure 85. Now, each of the data ranges in the single page field to be created must be defined, 

one range for each of the three product lines – Creams, Lotions, and Scrubs. 

In our example, all of the ranges to be consolidated are on separate worksheets in a single workbook, but 

the data ranges can be consolidated from multiple workbooks. To consolidate ranges from multiple 

workbooks, simply open the other workbooks and point to the data ranges during the PivotTable creation 

process. 
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Alternatively, type in the data ranges using the following format. 

[workbook name] sheet name ! range 

Make sure to include the brackets around the workbook name and the exclamation point between the sheet 

name and the range specification. Using defined names to define the data ranges in the individual 

workbooks will make the task easier and less prone to error. 

 

Figure 85 - Using the Collapse Dialog Button when Highlighting Ranges 

Click on the Collapse Dialog button, shown in Figure 85 at the right end of the Range box, to hide 

temporarily the dialog box. Then, using the mouse, highlight the range to be included in the report and click 

on the Collapse Dialog button to redisplay the dialog box. Click Add to add the range to the report. In the 

Field one box, enter the item name. Each of the ranges added in the dialog box will have its own item name 

– in this example, Creams, Lotions, and Scrubs. The completed dialog appears in Figure 86. 
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Figure 86 - Naming Each Field When Adding the Field Range 

Click Next. Choose to create the PivotTable on a new worksheet and then click Finish. After grouping 

Months into Quarters and making some minor formatting changes, the initial PivotTable should resemble 

the one shown in Figure 87. 

 

Figure 87 - Initial Consolidation PivotTable Created from Product Data 
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Review Questions 
 
The review questions accompanying this course are designed to assist you in achieving the 
course learning objectives. The review section is not graded; do not submit it in place of your 
final exam. While completing the review questions, it may be helpful to study any unfamiliar 
terms in the glossary in addition to course content. After completing the review questions, 
proceed to the review question answers and rationales. 
 
1. Which of the following is accurate regarding single variable data tables? 
 

a. In order to begin the function, you must create a formula at the top of the column as 
the “instruction” to Excel on how the math for that variable will function. 

b. A single variable data table is very beneficial in forecasting because the formulas can 
be very complex. 

c. A single variable data table is also referred to a pivot table. 
d. Reference to a “table” refers to a single variable data table in Excel “lingo.” 

 
2. All of the following functions can be found under the What-if icon EXCEPT: 
 

a. Scenario manager. 
b. Goal seek. 
c. Forecast sheet. 
d. Data table. 

 
3. The primary benefit of using scenario manager is: 
 

a. To eliminate multiple Excel files of the same budget and facilitate changing a single 
formal or variable across multiple scenarios. 

b. To track different people’s changes to the assumptions. 
c. To keep track of the timeline of the document creation. 
d. To store and track the rationale for various scenario inputs. 

 
4. Which of the following tools would help the user validate a sales forecast submitted by 

the sales director? 
 

a. Multi-variable data table. 
b. Scenario Manager. 
c. Regression analysis. 
d. Solver. 
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5. To create a trend line, the user must first: 
 

a. Create a new scenario. 
b. Create a graph of the data. 
c. Use solver to get the defined result for each period. 
d. Create a new data table. 

 
6. The moving averages function is accessed by: 
 

a. Clicking on the developer tab. 
b. Right-clicking on any cell in a data table. 
c. Clicking on the formula tab. 
d. Clicking on the data analyzer add-in. 

 
7. Which of the following statements regarding the NPV function in Excel is accurate? 
 

a. Users cannot calculate NPV in Excel due to the uneven and irregular nature of “real 
world” cash flows. 

b. The Excel NPV cash flow formula gives a good starting point for analyzing the net 
present value of a project’s cash flows. 

c. The NPV function in Excel requires some adjustment because the “zero time period” 
actually calculates as 1 year from today rather than as today. 

d. The IRR formula in Excel functions has a better NPV calculation than the NPV 
formula. 

 
8. Which of the following is accurate about “good spreadsheet” creation? 
 

a. Formulas should only contain cell references especially as they relate to assumptions. 
b. The user should create a log with references to all formulas. 
c. Comments should be displayed in order to assist the user. 
d. Assumptions contained within formulas should contain a comment indicating such. 

 
9. Which of the following statements is accurate regarding the watch window? 
 

a. The watch window remains open on the right hand side of the spreadsheet in a 
separate section outside the spreadsheet. 

b. The watch window can hold any cells within the current spreadsheet or any tab within 
the current workbook only. 

c. The watch window is found through the add-in function of Excel. 
d. The watch window can contain cells from other linked workbooks as well as cells 

within the current workbook. 
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10. Which of the following statements is accurate regarding best practices for linked 
workbooks? 

 
a. Use a point and click link to tie the workbooks together. 
b. Add comments in the destination workbook to provide the reference to the source 

workbook. 
c. Use a defined name in the source workbook prior to creating the link. 
d. Use FindLink when creating links between workbooks. 

 
11. Which of the following statements regarding data consolidate is accurate? 
 

a. In order to consolidate data on different tabs, you need to make sure your rows and 
columns are consistent across the sheets. 

b. When consolidating data, you can consolidate data in asymmetrical data ranges. 
c. When selecting the data to consolidate, you must include the row and column headers 

in your range. 
d. In order to consolidate data, you must define and name the ranges. 

 
12. PivotTables are: 
 

a. Accessed through an add-in. 
b. A data analytics tool. 
c. Primarily used for reporting. 
d. Created via named arrays. 
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Review Question Answers and Rationales 
 
Review question answer choices are accompanied by unique, logical reasoning (rationales) as to 
why an answer is correct or incorrect. Evaluative feedback to incorrect responses and 
reinforcement feedback to correct responses are both provided. 
 
1. Which of the following is accurate regarding single variable data tables? 
 

a. In order to begin the function, you must create a formula at the top of the 
column as the “instruction” to Excel on how the math for that variable will 
function. Correct. Excel needs to have a basis for creating the calculations and 
that is done by putting in the formula at the top of the column. 

b. A single variable data table is very beneficial in forecasting because the formulas can 
be very complex. Incorrect. A single variable data table is not very complex and a 
formula could be substituted fairly easily. 

c. A single variable data table is also referred to a pivot table. Incorrect. A pivot table is 
an entirely different tool than a data table. 

d. Reference to a “table” refers to a single variable data table in Excel “lingo.” Incorrect. 
A table and a data table are two unique tools. 

 
2. All of the following functions can be found under the What-if icon EXCEPT: 
 

a. Scenario manager. Incorrect. Scenario manager is located under the What-if icon. 
b. Goal seek. Incorrect. Goal seek is part of the What-if functions. 
c. Forecast sheet. Correct. Forecast Sheet has its own icon on the data tab. 
d. Data table. Incorrect. Data table is part of the What-if functionality. 
 

3. The primary benefit of using scenario manager is: 
 

a. To eliminate multiple Excel files of the same budget and facilitate changing a 
single formal or variable across multiple scenarios. Correct. Rather than having 
a bunch of different spreadsheets for each scenario, scenario manager keeps 
these integrated so that a single change to a formula or constraint will update 
across all versions. 

b. To track different people’s changes to the assumptions. Incorrect. The primary benefit 
is not in change tracking or managing, rather it is keeping track of the final version of 
multiple scenarios. 

c. To keep track of the timeline of the document creation. Incorrect. The primary benefit 
is not in the tracking over time. 

d. To store and track the rationale for various scenario inputs. Incorrect. Any such notes 
about rationales or assumptions need to be noted somewhere within the document 
itself. 
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4. Which of the following tools would help the user validate a sales forecast submitted by 
the sales director? 

 
a. Multi-variable data table. Incorrect. This tool may help to prepare such a forecast but 

is not the best tool for validating it. 
b. Scenario Manager. Incorrect. This can help with preparing different scenarios for 

review and analysis, but it is not the best tool for testing a forecast. 
c. Regression analysis. Correct. Regression analysis can help check the validity of a 

forecast using past actual results. 
d. Solver. Incorrect. Solver is a good tool for getting to a result. 

 
5. To create a trend line, the user must first: 
 

a. Create a new scenario. Incorrect. It is not necessary to be in a scenario in order to 
create a trend line. 

b. Create a graph of the data. Correct. Once the user has a graph, he/she right-
clicks on a data point in order to create the trend line. 

c. Use solver to get the defined result for each period. Incorrect. It is not necessary to 
use solver; the user may have the data points for the graph. 

d. Create a new data table. Incorrect. A data table is not necessary for using the trend 
line function; the user just needs data which can be put in graphical format. 

 
6. The moving averages function is accessed by: 
 

a. Clicking on the developer tab. Incorrect. The user must access the data tab to get to 
the data analyzer. 

b. Right-clicking on any cell in a data table. Incorrect. Moving averages is a data 
analysis tool located in the data analysis add-in. 

c. Clicking on the formula tab. Incorrect. The data analyzer is found under the data tab. 
d. Clicking on the data analyzer add-in. Correct. The moving averages function 

can be accessed by clicking on the data analyzer tab. 
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7. Which of the following statements regarding the NPV function in Excel is accurate? 
 

a. Users cannot calculate NPV in Excel due to the uneven and irregular nature of “real 
world” cash flows. Incorrect. You can use the formula, with some adjustments, or you 
can set up the uneven cash flows and calculate the NPV outside of the Excel formula. 

b. The Excel NPV cash flow formula gives a good starting point for analyzing the net 
present value of a project’s cash flows. Incorrect. The formula as is, must be adjusted 
to be technically accurate and it does not provide the flexibility to adapt to uneven 
cash flows. 

c. The NPV function in Excel requires some adjustment because the “zero time 
period” actually calculates as 1 year from today rather than as today. Correct. 
The user can start with the NPV formula but must make some adjustments since 
the formula actually adds 1 discount period to each year which is not accurate. 

d. The IRR formula in Excel functions has a better NPV calculation than the NPV 
formula. Incorrect. The IRR calculation is completely different from the NPV 
formula. 

 
8. Which of the following is accurate about “good spreadsheet” creation? 
 

a. Formulas should only contain cell references especially as they relate to 
assumptions. Correct. Assumptions and other “hard-coded” numbers should not 
be put in formulas as it makes it difficult to facilitate changes and identify 
assumptions. 

b. The user should create a log with references to all formulas. Incorrect. That would be 
time-consuming and inefficient. 

c. Comments should be displayed in order to assist the user. Incorrect. This is personal 
preference, but does tend to cover other areas of the worksheet. 

d. Assumptions contained within formulas should contain a comment indicating such. 
Incorrect. Comments are certainly helpful regarding the source of the data or who 
provided it but numbers, especially, assumptions should not be coded into the formula 
rather there should just be cell references so that the numbers and assumptions can be 
easily seen and changed as needed. 
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9. Which of the following statements is accurate regarding the watch window? 
 

a. The watch window remains open on the right hand side of the spreadsheet in a 
separate section outside the spreadsheet. Incorrect. The user can place the watch 
window on the right hand side, or he/she can layer the window on the spreadsheet or 
move it or resize it as needed. 

b. The watch window can hold any cells within the current spreadsheet or any tab within 
the current workbook only. Incorrect. The watch window can hold cells within the 
current spreadsheet or any tab within the current workbook as well as cells from 
linked workbooks. 

c. The watch window is found through the add-in function of Excel. Incorrect. The 
watch window is found on the Formulas tab. 

d. The watch window can contain cells from other linked workbooks as well as cells 
within the current workbook. Correct. The user can update to watch cells in 
other linked workbooks as well as any cells within the current workbook. 

 
10. Which of the following statements is accurate regarding best practices for linked 

workbooks? 
 

a. Use a point and click link to tie the workbooks together. Incorrect. Using a point and 
click link to tie the workbooks together is the process for creating a link, however, a 
best practice is to use defined names in the source workbook to help ensure that 
simple changes in the source workbook don’t destroy the integrity of the linked data. 

b. Add comments in the destination workbook to provide the reference to the source 
workbook. Incorrect. The formula itself provides the details of the source workbook 
and cell. 

c. Use a defined name in the source workbook prior to creating the link. Correct. 
By using a defined name, the user will ensure the integrity of the cell and the 
link. 

d. Use FindLink when creating links between workbooks. Incorrect. This is a nice tool 
to help the user uncover broken links, but is not a best practice in the creation of the 
links. 

 
11. Which of the following statements regarding data consolidate is accurate? 
 

a. In order to consolidate data on different tabs, you need to make sure your rows and 
columns are consistent across the sheets. Incorrect. You can consolidate asymmetrical 
ranges, but you need to include the row and column headers. 

b. When consolidating data, you can consolidate data in asymmetrical data ranges. 
Correct. To do this, you must include the row and column headers in the range. 

c. When selecting the data to consolidate, you must include the row and column headers 
in your range. Incorrect. You do not need to include row and column headers if the 
data on all of the sheets is symmetrical. 

d. In order to consolidate data, you must define and name the ranges. Incorrect. You 
simply point and click to select the range of cells; they do not need to be defined. 
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12. PivotTables are: 
 

a. Accessed through an add-in. Incorrect. PivotTables are a standard tool within Excel. 
b. A data analytics tool. Incorrect. PivotTables are not primarily a data analytics tool 

like one of the statistical tools; rather PivotTables are for the presentation and 
reporting of data. 

c. Primarily used for reporting. Correct. PivotTables are a powerful presentation 
tool for aggregating data for reporting. 

d. Created via named arrays. Incorrect. PivotTables are created through the insert 
PivotTable icon. 
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Glossary 
 
This is a glossary of key terms with definitions. Please review any terms with which you are not 
familiar. 
 
Add-ins: Certain functions which are not inherent in the normal installation of Excel and which 
have to be specifically added in order to be accessed. 
 
Analysis Tool Pack Add-in: An add-in that provides more powerful analysis tools than the 
simple trend line. 
 
Array: A special type of formula within Excel that is capable of various powerful functions. It is 
represented in a formula with braces { }. In order to edit a formula containing an array without 
destroying the array, you must press Ctrl+Alt+Enter at the same time. 
 
Budget: A committed financial plan of action. 
 
Capital budgeting: The process of evaluating and planning for acquisitions of assets to be used 
in the business. 
 
Circular references: Formulas where one number depends on another which is dependent on 
that number. For example, taxes where the federal calculation depends on the amount of state 
tax, but the amount of state tax depends on the amount of federal tax. It is best to avoid such 
references whenever possible, however, if the situation cannot be avoided, go to 
File>Options>Formulas>Enable iterative calculations. Keep in mind that this is a “session” 
setting – it only applies until the workbook is closed. 
 
Coefficients: The fixed and variable outputs. 
 
Data consolidate: A function which consolidates data from multiple sheets within the 
workbook. 
 
Data tables: A functionality within Excel that assists with the performance and presentation of 
“what if” scenarios. 
 
Defined names: A tool that allows the user to create usable names for reference rather than 
seeing a cell reference that is not meaningful for understanding the data represented in that cell. 
 
Find link: An Excel add-on which helps to locate broken links. 
 
Forecast: A tool used to feed budgets or other planning tools. 
 
Forecast function: A tool that helps to forecast the future based on past experience. 
 
Goal seeking functionality: A function that allows the user to specify the end result and Excel 
will identify the inputs which deliver that result.  
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Internal Rate of Return (IRR): The rate of return which will discount all of the cash flows of a 
project to zero.  
 
Monte Carlo Simulation: A tool for calculating probability distributions.  
 
Moving averages: A tool to help smooth out seasonal fluctuations.  
 
Multi-variable data table: One of two forms of data tables within Excel.  
 
Net Present Value (NPV): A form of analysis used in decision-making for capital outlays. It 
involves discounting the cash flows. A positive NPV means that the project should be accepted. 
 
Nominal dollars: Projections of cash flows which include the impact of inflation. 
 
Probability distribution: A forecasting strategy used as an alternative to single point estimates. 
 
R2: A measure of the “fit” of the data. This is used in regression analysis and the creation of 
trend lines. R2 of .8 to 1.0 (either positive or negative) is indicative of a good fit. 
 
Real dollars: Projections of cash flows which exclude the impact of inflation. 
 
Regression analysis: A tool used to help with forecasting both from the side of creating 
forecasts based on past results and from the side of validating someone else’s forecast. 
 
RiskAMP: A tool which uses Monte Carlo methodology in budgeting. 
 
Scenario manager: A tool designed to help manage multiple iterations of a budget or forecast. 
 
Scenario summary report: A report within scenario manager that allows the user to present all 
of the managed scenarios side-by-side. 
 
Single point estimate: An estimate that is almost always wrong (sales will be $X). An 
alternative is to use probability distribution. 
 
Single variable data table: One of two forms of data tables within Excel. 
 
Slope: A function within data analysis that tells the user the impact of 1 unit of input (in the 
instructor example, 1 dollar of advertising is the input and 85.179 is the resulting increase in 
sales.) 
 
Solver: A function that allows the user to solve multi-variable equations which are closer to real 
life examples and can incorporate constraints. 
 
Sum-through formula: A method of summing the same cell reference in a range of worksheets 
within the same workbook. 
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Trend line: A function within a graph that essentially performs a regression analysis on the data. 
 
Time period zero: In NPV calculations, time period zero means today.  
 
VLOOKUP Function: An Excel formula that uses one known piece of data to then go to a table 
and lookup a related piece of data. For example, using an employee’s name to lookup their 
employee ID number, phone number, etc. from a table which contains all of the related data. 
 
Watch window: A function which allows the user to watch certain cells when changes are made 
to other identified cells. 
 
What if analysis: A process of analyzing different scenarios to take into consideration that many 
inputs are estimates and can could be different than projected. What if analysis provides insight 
into the result if this or that data input is higher or lower. 
 
XIRR function: A function which solves the IRR problem of uneven cash flows. 
 
XNPV function: A function which solves Excel’s NPV calculation problem and the problem of 
uneven cash flows. 
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Course Expiration Date 
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Complete this assessment online at www.westerncpe.com and receive your certificate and 
results instantly! 

1. The table function in Excel is designed specifically to help solve which of the following
problems?

a. Data formatting.
b. Highlighting important information.
c. Performing “what if” analysis.
d. Subtotaling.

2. In order to create a data table, click on the _______ tab.

a. Formula.
b. Developer.
c. Page Layout.
d. Data.

3. After selecting the goal seeking option, the user is asked to specify _______ inputs
into the goal seeking equation.

a. 2.
b. 3.
c. 4.
d. 5.

4. A significant weakness with respect to goal seeking is:

a. The complexity of setting up the scenario.
b. The difficulty of interpreting the calculated result.
c. It ignores constraints.
d. The limited uses.

http://www.westerncpe.com/
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5. In order to access “add-ins” for Excel, the user must:

a. Go online to the Microsoft Office website and download them.
b. Purchase a special add-in bundle.
c. Go to the data tab and right-click on the analysis section to access the add-ins.
d. Go to File/Options/Add-in and activate the add-in.

6. Scenario manager is engaged on a worksheet-by-worksheet basis within a workbook and
each scenario can be used to drive up to ______ different variables.

a. 8.
b. 16.
c. 32.
d. 64.

7. The scenario summary report breaks the information by scenario into:

a. Assumptions and results.
b. Inputs and results.
c. Options and output.
d. Inputs and outputs.

8. The forecast function is actually building a _______ behind the scenes.

a. Regression analysis.
b. Forecast worksheet.
c. Scenario.
d. Graph.

9. To calculate a moving average, one of the first things that you need to define in the
dialogue box is:

a. Output option.
b. Chart output.
c. Input range.
d. Data labels.

10. Which of the following statements about RiskAMP is accurate?

a. RiskAMP can compute normal probability distributions.
b. RiskAMP is a component within the data analyzer add-in.
c. RiskAMP requires the user to perform some minor programming to get the optimal

results.
d. RiskAMP is used to project certainty in the budget.
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11. When analyzing the results of the Monte Carlo simulation, the risk inherent in the project
can be determined by looking at the:

a. Bin and frequency.
b. Frequency and value.
c. Percentile and value.
d. Value and bin.

12. Capital budgeting should be done using:

a. LINEST.
b. RiskAMP.
c. Solver.
d. Net present value.

13. In capital budgeting, which of the following statements is accurate?

a. The analysis should use real dollars.
b. The analysis should use inflation-adjusted dollars.
c. The analysis should use nominal dollars.
d. The analysis can use either nominal dollars or real dollars as long as the variable is

used consistently throughout the analysis.

14. In order to have cell comments print along with the document, the user must:

a. Go to the File/Options section in order to find comments.
b. Make a selection on the Page Setup dialogue box to enable comments to print.
c. Go under the File/options/advanced to find the comments settings.
d. Show comments on the page and then print.

15. The IFERROR function:

a. Identifies inaccurate formula parameters.
b. Substitutes another value for any invalid calculations like dividing by 0.
c. Finds inconsistencies in formulas throughout the spreadsheet row or column.
d. Provides conditional formatting when identified errors are detected.

16. In a VLOOKUP formula, if you want the lookup to find an exact match for the lookup,
you must put _______ on the end of the formula; otherwise, it will find an approximate
match.

a. False.
b. 1. 
c. 0. 
d. No.
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17. In order to enable “iterative calculations” for circular references, the user must:

a. Enable the “calculation” add-on.
b. Enable iterative calculations in the Options section under the File menu.
c. Enable calculator on the Data tab.
d. Right-click on the circular reference cell and click “enable calculation.”

18. The estimated error rate for Excel workbook formulas is:

a. 25%.
b. 40%.
c. 65%.
d. 90%.

19. The data consolidate function is located under the ______ tab.

a. Add-ins.
b. Formula.
c. Data.
d. Developer.

20. In order to create conditional formats, the user must:

a. Create an array.
b. Create a rule.
c. Name a data range.
d. Use a formula.
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*E-mail address MUST be unique (not shared with another CPA) for Western CPE to grade your assessment 

Name of purchaser (if other than person taking assessment):  

If course was purchased as part of the MEGA TAX LIBRARY please include $4/credit for grading: 

VISA/MC/Discover/Amex #  Exp.  

Course expires 1 
Year from date of 

purchase or 
enrollment 

Online Grading: visit www.westerncpe.com to complete your assessment 
online and receive your certificate of completion and results instantly. 

1. ___ 5. ___ 9. ___ 13. ___ 17. ___

2. ___ 6. ___ 10. ___ 14. ___ 18. ___

3. ___ 7. ___ 11. ___ 15. ___ 19. ___

4. ___ 8. ___ 12. ___ 16. ___ 20. ___
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Course Evaluation 
Excel Budgeting and Forecasting 
Course # 2164594, Version 1706

Thank you for taking the time to fill out this course and customer experience evaluation.  Your responses help us to 
build better courses and maintain the highest levels of service.  If you have comments not covered by this 
evaluation, or need immediate assistance, please contact us at 800.822.4194 or wcpe@westerncpe.com. 

Course and Instructor Evaluation 

1. Please answer the following related to the content of the course:

Strongly 
Disagree Disagree Neutral Agree Strongly 

Agree 

The stated learning objectives were met. O O O O O 

The course materials were accurate, relevant, and contributed 
to the achievement of the learning objectives.  O O O O O 

The stated prerequisites were appropriate and sufficient. O O O O O 

Based on 50 minutes per credit hour, the time to take this 
course accurately reflects the credit hours assigned to it.  O O O O O 

The instructor was knowledgeable and effective. O O O O O 

2. Were there any questions you felt were confusing or had incorrect answers listed?  If so, please give the
question number and a brief description of the issue:

3. Please provide any additional comments specific to the educational content or author of this course:

mailto:wcpe@westerncpe.com
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4. Do you have ideas for future course topics?  If so, please list them along with any known subject matter experts
we might contact to develop the course:

Customer Experience 

5. Please rate your overall experience with Western CPE:

Unsatisfactory Improvement 
Needed 

Meets 
Expectations 

Exceeds 
Expectations Exceptional 

If you interacted with our Customer 
Service team, please rate the quality 
of service you received. 

O O O O O 

If you purchased your course online, 
please rate the quality of your e-
commerce experience. 

O O O O O 

“My Account” information includes 
the tools necessary to access courses 
and track those completed. 

O O O O O 

6. Please indicate the likelihood of your purchasing the listed course formats from Western CPE:

Not at all Not very 
likely Possibly Likely Highly 

Likely 

Self-Study O O O O O 

Webcast OnDemand O O O O O 

Live Webcast O O O O O 

Resort Conference or Seminar O O O O O 
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7. Please use the box below to provide any additional comments related to your educational experience with
Western CPE.

8. If you are willing to provide a quote about this course, or Western CPE in general, that we may use in our
promotional materials, please state it below.  Be sure to include your name, title, city, and state.
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